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1 Getting Started 

1.1  In t roduct ion  
The Fire Effects Tradeoff Model Version 4 (FETM 4) is a landscape-scale, strategic planning 
model designed to simulate the long-term tradeoffs between wildland fire and various fuel 
treatment alternatives over large areas of the landscape encompassing diverse environmental 
conditions, natural fire regimes, and land management policies.  

FETM 4 has nationwide application, and can be used by any federal, state, or private 
organization. The model is aimed at land management planners, fire planners, air quality 
specialists, and other resource specialists who seek a model capable of assessing the long-term 
consequences of land management practices, and which can provide the information needed to: 

 Support budgeting and planning decisions 
 Identify the economic and environmental tradeoffs between fuel treatment alternatives 

and wildland fire 
 Assess the long-range impacts to ecosystems 
 Assist fuel specialists in identifying specific vegetation types to target for fuel reduction 

A diversity of outputs are available from FETM 4, including annual fuel treatment acres (planned 
and accomplished), annual wildland fire acres burned by fire intensity level, annual vegetation 
composition, annual pollutant emissions, and annual costs and benefits of wildland fire versus 
various fuel treatment alternatives. 

At its core, FETM 4 is a vegetation dynamics model that simulates changes in vegetation 
composition over time in response to various human-caused and natural disturbances. A wide 
variety of disturbances may be accounted for in the model, including timber harvesting and other 
forms of fuel removal (e.g., firewood collection), mechanical fuel treatments, prescribed fire, 
wildland fire, windthrow, insects, disease, and, in the absence of disturbance, natural succession. 
A key feature of FETM 4 that distinguishes it from other vegetation dynamics models is its link 
between vegetation composition (fuel loading) and wildland fire behavior and effects. For 
example, an increase in the proportion of highly flammable vegetation classes in an area will 
produce a concomitant increase in the number of wildland fire acres burned annually. Over time, 
this increased number of wildland fire acres burned (a form of natural fuel treatment) can, in 
combination with other management actions, reduce the proportion of highly flammable 
vegetation classes across the landscape and lead to a reduction in the number of wildland fire 
acres burned annually.  

The amount of wildland fire and other fuel treatments required to “tip the scales” in favor of 
lower average flammability (and lower numbers of wildland fire acres burned annually) depends 
on the magnitude of the fuel treatments (outflow) as it relates to the rate of recruitment into the 
more flammable vegetation classes (inflow) resulting from a combination of natural disturbances 
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(e.g., insects, disease, windthrow), management activities (e.g., timber harvesting), and natural 
succession. 

FETM 4 is non-spatial, meaning that while it can predict the overall outcome of a treatment (for 
example, prescribed fire) within a specific Analysis Area, it cannot predict where specific 
impacts may occur. For example, within a particular stand type (immature mixed conifer, for 
example), FETM 4 can predict the number of acres of the stand that will be affected by wildland 
fire, but cannot predict where within the stand those effects will occur or if they will be 
contiguous or dispersed. 

Because it is a dynamic model, FETM 4 can predict changes in landscape composition over time. 
The resultant changes can then be used by the model to predict air quality emissions during a 
planned or unplanned fire event, costs associated with controlled or uncontrolled burns, and 
treated acres.  

FETM 4 is also a stochastic model because it includes one or more random variables. Currently 
the random variables include annual wildland fire numbers by fire weather class and wildland 
fire size for the fires that fall outside the range of recent historical data for the Analysis Area. 

1.2  System Speci f icat ions 
 
 Minimum Recommended 

Processor Speed 266 MHz 400+ 

Available Disk Space 200 MB 400 MB 

Random Access Memory 64 MB 128 MB+ 

Screen Resolution Running FETM 4 at less than 
1024 by 768 pixels may result in 
the right-hand side of the screen 

being cut off in the display. 

1024 by 768 pixels 

Color Resolution  True Color (32-bit) 

CD-ROM Drive Required Required 

CD-Read/Write Drive  Recommended for storing 
Analysis Area-specific 

database files 
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FETM 4 must be run at a screen resolution of 1024 by 768 pixels or greater for you to see all of 
the screens. To set your screen resolution, click on your Windows “Start” button, and then select 
“Settings,” and then “Control Panel.” At the Control Panel, double click on the “Display” icon. 
Select the “Settings” tab. In the lower left corner of the dialog box is a slide control labeled 
“Screen Area.” Slide the control toward “More” until the reading under the slide control reads 
“1024 by 768 pixels” or greater, then mouse click on “OK.” The computer will automatically 
reset your screen resolution. You can also reset your color resolution in this same area by 
selecting the appropriate color resolution from the pull-down menu. 

1.3  Insta l la t ion  
To install FETM 4 on your computer: 

 Insert the FETM 4 CD-ROM in your CD drive. 
 The Setup routine has an auto-start feature that automatically begins the setup process.  
 If the program doesn’t auto-start:  

 From the Windows START menu, select “Run.” 

 At the “Run” dialog box, select “Browse.” Select your CD drive, then select the 
FETM subdirectory. 

 Once you are in the FETM subdirectory, click twice on the “Setup” icon.  

The Setup program will automatically guide you through the remainder of the 
process. The following “shortcut” icon will automatically be installed on your 
computer desktop. 

FETM 4 requires that you have a version of the Personal Computer Historical Analysis (PCHA) 
available on your computer system. If you do not currently use PCHA, you can obtain a copy 
online at: 

http://www.fs.fed.us/land/fire/pcha.htm 

Instructions for installing that program are included online. 

1.4  On Your  Mark…Navigat ing Ins ide  FETM 4  
Before you begin to use FETM 4, there are a few things to know about the program and how it 
works. 

I ndex  T ree  D iagram 

The opening screen of FETM 4, shown below, features an Index Tree on the left and a graphic 
display on the right. The Index Tree will run in the background at all times while you are using 
FETM 4. You can access it at any time by simply minimizing the active window. The Index Tree 
serves a directory to the program—you can click on any of the colored boxes, called branch 
nodes, to bring up sections of the program. You should generally start at the top of the list and 
progress to the bottom, expanding the branch nodes as needed to access additional forms.  
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Some branch nodes are marked with small boxes to the left that contain either a + or a – sign. A 
plus sign indicates that the branch node is contracted—specifically, that there are more menu 
items beneath the node. A minus sign indicates that the branch node is expanded and all choices 
are currently shown. 

Process  D iagram 

A process diagram is also available from the help menu on the opening screen. The process 
diagram is shown in rough order of execution and should help you decide which areas of the 
model need your input. To access the process diagram, select “Help” from the pull-down menu 
on the opening screen, and then select “Process Diagram.” A printout of the Process Diagram is 
included at the end of this section. 

On-L ine  He lp  Sys tem 

Online help is also available from the pull-down menu. Simply select “Help,” then “Contents” 
and select the appropriate topic. Online help is not available for the HAIA portion of the 
program. 
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Read-On ly  Boxes  

Several screens, particularly pop-up boxes, have an “Open as read-only” box at the bottom of the 
screen. This option is frequently non-functional—the box is standard in the browser box utility 
that FETM 4 uses. Please ignore it. 

Chang ing  Co lumn Wid ths  in  Spreadshee t  Forms  

Several forms may appear onscreen with overlapping columns. To change the column widths, 
simply hold the cursor on the vertical line separating the column headings until a double vertical 
line appears ( ). Holding down the left mouse key, move the double vertical line to the left or 
right to change the column width. You can save the column widths on these screens by selecting 
the gray “Save column widths” button at the bottom of the screen. 

Ente r ing  Da ta  on  Forms  

FETM 4 uses input from external files as well as user input. In addition, some forms require user 
input to compute information that will appear on other forms. Boxes that are not shaded allow 
user input or can be edited. Boxes that are shaded are shown for your information, but cannot be 
edited. 

You must exit one program area before you can access another area of the program. You can do 
this by clicking on the “X” in the upper right-hand corner of the window. Some windows also 
have a “Close” button located at the bottom of the screen that you can select to close the window. 
Or you can simply click on any other Index Tree item without closing the current window first; 
the current form will be automatically closed before the new form opens. 

Too l  T ips  

Tool tips are pop-up text boxes that explain the contents of the cell you point to with your mouse. 
They are only available on the command button of selected forms. Tool tips are also available on 
the “Run Status” form to indicate the screening criteria that were used to determine 
completeness. This will be explained in further detail in the “Run Status” section of this manual. 

1.5  Get  Set…Some Important  In format ion on 
the  Model ing  Process 
Before you begin using FETM 4, here are some important facts to know about the modeling 
process and how it should be conducted.  

Forming  an  FETM 4  App l i ca t ion  Team 

Because of its breadth and high degree of complexity, FETM 4 is a model that is best used in a 
team setting. FETM 4 will require input and expert knowledge from several natural resource 
disciplines, including, but not limited to, fire planners, fire ecologists, air quality specialists, fuel 
specialists, and vegetation management specialists. At least one member of the team should be a 
person who is highly computer literate, and whose skill and experience are in the discipline  
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area for which the modeling analysis is being conducted. For example, if FETM 4 is being used 
to analyze the long-term effects of alternative management policies as part of a forest plan 
update, then the team should include a forest-planning specialist. Or, in another example, if 
FETM 4 is being used to evaluate the tradeoffs between wildland fire and prescribed fire smoke 
emissions, then the team should include a regional or zone air quality specialist. The team 
leader’s responsibility is to coordinate the group of specialists. No single person is likely to have 
the range of skills necessary to run the model by themselves. In our experience, the average 
FETM 4 team consists of five professionals. Appendix A is a description of FETM 4 team roles.  

Overv iew  o f  the  Mode l ing  Process  

The FETM 4 model that accompanies this manual has been programmed with a demonstration 
(Demo) scenario to help you understand how the program works. The Demo scenario includes 
98 fuel characteristic classes, and is based on a forest mixture of 2/3 chaparral and one to two 
timber forest types. The Demo scenario is based on data from the Angeles National Forest in 
southern California. It has been modified for instructional purposes, and should not be taken as 
an accurate reflection of that analysis area. Your results will be different. 

The FETM 4 modeling process is a series of five steps, described below. 

S e l e c t i n g  a n  A n a l y s i s  A r e a  

FETM 4 has been designed to analyze impacts within a particular geographic area called an 
Analysis Area. An Analysis Area may be a single administrative unit (AU) (for example, a 
National Forest, BLM District, or National Wildlife Refuge), or any combination of administra-
tive units (for example, two or more National Forests or BLM Districts), or portions of admin-
istrative units, provided those different units form a single, contiguous area. The modeling 
objectives usually dictate the appropriate geographic scale. 

S t r a t i f y i n g  t h e  A n a l y s i s  A r e a  b y  F C C s  

Once the Analysis Area has been identified, it may be stratified into a series of user-designated 
vegetation and fuel-loading classes called Fuel Characteristic Classes (FCCs). Each FCC is a 
unique description of the total fuel bed, which begins at mineral soil and ends at the top of the 
tallest shrubs or trees occupying each site. In FETM 4, FCCs are described in terms of 
qualitative, quantitative, and stand characteristics, which are summarized below. 

The four qualitative attributes are: 

 Predominant vegetation 
 Age class 
 Loading class 
 Activity class 
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FCCs can be described quantitatively in terms of a host of physical parameters that relate to fuel 
loading of dead-and-down woody fuels, including: 

 Size class 
 Duff loading 
 Fuel bed depth 
 Fuel moisture content 

Lastly, FCC descriptions include stand characteristics such as:  

 Height to the base of the live crown 
 Foliage and 1-hour fuel loading 
 Stand density 
 Average stand diameter 
 Total stand height 

Because of their differing characteristics, each FCC has potentially different fire behavior (e.g., 
fire spread rate), disturbance effects, fuel consumption, and emissions. 

The process of stratifying the area into FCCs is one of the more challenging aspects of FETM 4, 
mainly because how best to characterize the Analysis Area is entirely at the user’s discretion. 
There is no limit on the number of FCCs that may be defined: the user may define just a few, or 
several hundred. The greater the number of FCCs selected, the greater the resolution in defining 
successional and disturbance pathways, the greater the accuracy of the simulation process. 
However, the decision to employ many FCCs comes at a considerable price in terms of the 
difficulty of obtaining the required inputs and the time it takes to enter the data and to run the 
model. Experience has shown that most Analysis Areas of up to 1,000,000 acres in size can be 
adequately described with fewer than 200 FCCs. 

D e f i n i n g  D i s t u r b a n c e  T y p e s  a n d  E f f e c t s  

Once the Analysis Area has been stratified into FCCs, the types and effects of disturbances may 
be characterized. The effects of various management-related and natural disturbances on 
vegetation composition and fuel loading are simulated in FETM 4 using a system of schedules 
and effects matrices. The schedules define the magnitude of the disturbance (i.e., the number of 
acres that are affected annually), and the effects matrices define the direction of change following 
the disturbance. In the case of wildland fire disturbances, FETM 4 predicts the magnitude of the 
disturbance. 

Form-based schedules are used to assign the magnitude of disturbance from selected 
management activities, such as timber harvesting, mechanical fuel treatments, and prescribed 
fire. Schedules are also used to define the magnitude of disturbance from some natural causes 
such as insects, disease, and windthrow. Each FCC must be scheduled separately. If no acres are 
entered in the schedule for an FCC, it means that no disturbance is expected for that FCC. The 
effects matrices are populated with fractional numbers that determine the number of acres 
transferred from the parent FCC to one or more sibling FCCs following disturbance. FETM 4 
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contains one matrix for each disturbance type except fire, which uses three separate disturbance 
matrices (one for each of three fire intensity classes: low, moderate, high). Each column in the 
matrix represents a different parent FCC; each row represents a different sibling FCC.  

In FETM 4, the effects of a disturbance are always manifested as a transfer in the number of 
acres from one FCC to one or more FCCs following the disturbance. For example, the effect of a 
moderate-intensity wildland fire in an overstocked, immature Ponderosa Pine FCC might be to 
transfer 50 percent of the parent FCC acres to bare ground, and 30 percent to an immature 
Ponderosa Pine FCC with a lower stand density and lower total surface fuel loading. In this 
example, 20 percent would remain in the parent FCC; that is, 20 percent of the area is assumed to 
be unaffected by a moderate-intensity wildland fire.  

D e f i n i n g  t h e  R e l a t i o n s h i p  b e t w e e n  t h e  F i r e  S p r e a d  R a t e  
a n d  E x p e c t e d  W i l d l a n d  F i r e  S i z e  

Wildland fire is treated as a random (stochastic) event for which size varies according to the fire 
weather conditions and the vegetation composition within the Analysis Area. The largest fires are 
expected to occur under high or extreme fire weather conditions, when the fire rate of spread is 
the greatest. Smaller fires are expected under low or moderate fire weather conditions, when the 
expected spread rates are lower.  

The accuracy of the fire size simulation in FETM 4 depends on a reasonable characterization of 
the relationship between the expected fire size and the fire rate of spread in each of four fuel 
categories: timber litter, slash, grass, and brush. To build these relationships, an experienced fire 
planner or fire behavior analyst is needed to evaluate the fire rates of spread required to achieve a 
set of fixed—or breakpoint—fire sizes: 0.25 acre, 10 acres, 100 acres, 300 acres, and 1,000 acres. 
A fire behavior analyst is also needed to survey the recent historical record and to extract 
representative wind-driven “escaped” wildland fires (that is, wildland fires that escaped initial 
attack), and whose size and active spread time is known.  

A separate but related task in FETM 4 is to characterize each of the four National Fire Danger 
Rating System (NFDRS) fire weather classes in terms of ranges of computed spread components. 
The median spread component for each fire weather class is used to determine the expected fire 
size in that fire weather class, and indirectly to determine the average weather conditions within 
each fire weather class. 

D e f i n i n g  S c e n a r i o s  a n d  R u n n i n g  t h e  M o d e l  

Prior to running the model, the user must define a scenario. A scenario (also called a run 
scenario) is a set of assumptions used to define a modeling analysis within the Analysis Area. A 
scenario is defined by the following inputs and assumptions (partial list): a set of FCCs with 
initial acreage estimates for each, a set of schedules and disturbance types, effects matrices, and 
other factors such as pollutant species to model, number of years in the simulation, and the 
number of simulation iterations over which to average simulation outputs.  
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FETM 4 may be run with a single iteration, or averaged over multiple iterations of the model. A 
single iteration provides the user with a view of the episodic pattern of wildland fire. Because of 
the stochastic nature of FETM 4, the outcome of individual simulations can vary widely; 
therefore, averaging multiple runs of FETM 4 is recommended to provide an adequate sampling 
of the consequences of wildland fire in combination with various fuel treatments designed to 
achieve certain resource objectives or to mitigate the hazard of wildland fire. 

Prior to initiating a run, the program will automatically display a “Run Status” form. This form 
contains a listing of the various required inputs, and the current status of the inputs is listed as 
either “Complete,” “Questionable,” or “Incomplete.” The model will not run if any “Incomplete” 
messages are found.  

Running the program may take from 5 minutes to 30 minutes depending on the complexity of run 
scenario and the speed of the machine that FETM 4 is running on. A model run consisting of 200 
FCCs, 7 levels of prescribed fire treatment, and 2 pollutants over 100 years of simulation takes 
about 5 minutes on a Pentium III/300 Megahertz coprocessor with 128 Megabytes RAM. 

After the run is complete, the user must load the outputs into the model database to view the 
graphs. This is discussed further in Section 5, Run Model. This process normally takes less 
than 5 minutes per scenario. A detailed discussion of FETM 4 ASCII Output Files is located in 
Appendix B. 

1.6  Go!  
The remainder of this manual is ordered to follow the process diagram. 
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2 Managing External Files 
 

 

 

 

 

 

 

 

 

2.1  L ink  PCHA/ I IAA F i les  

 

Prior to this step, you must obtain the appropriate PCHA and IIAA database files for each 
administrative unit found within the desired Analysis Area, and place the database files in a 
folder on your computer’s hard drive. These files may be obtained from the unit’s fire planning 
staff. Once obtained, the files may be stored anywhere on the hard drive that makes sense to the 
user and can be navigated to easily; the storage folder need not be placed in the same area as the 
FETM 4 program files. 

To link the PCHA and IIAA files, click on the colored box next to “Link PCHA/IIAA Files” on 
the Index Tree. The following pop-up window will appear onscreen:  

 

 

FETM 4 uses basic information on the administrative units that make up the 
Analysis Area, which it obtains from Microsoft Access database files produced by 
both the Personal Computer Historical Analysis (PCHA) and the Interagency Initial 
Attack Assessment (IIAA) models. PCHA is a PC program developed to complete 
the historical fire and weather analyses required for the National Fire Management 
Analysis System (NFMAS). PCHA is designed to help analyze historical wildland 
fire occurrence for wildland fire planning. IIAA is used to develop budget requests 
as part of the NFMAS process. 

In this section you will select and manage those files that will be used to support the 
modeling analyses that you perform in the “Manage Analysis Areas” section of the 
program. You will need to obtain these files from the fire management or fire 
planning specialist responsible for those administrative units that you intend to use 
in defining your Analysis Area. 

In this program area users load NFMAS descriptive information from their 
administrative unit-specific PCHA and IIAA database files. You must load a PCHA 
file before FETM 4 can be run. PCHA files can be obtained from the fire planning 
specialist responsible for those administrative units that you intend to include in 
your Analysis Area. In addition, FETM 4 requires that you have a version of PCHA 
available on your system. This can be obtained online at: 

http://www.fs.fed.us/fire/planning/nist/distribu.htm\ 
Installation instructions and a user guide are also available online.  
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Navigate to the directory containing the desired PCHA file. Next, highlight the PCHA file you 
want to link, then click on the “Open” command button. You may also double-click on the target 
file name. Disregard the “Open as read-only” option, which is not functional but comes standard 
in the browser box utility that FETM 4 uses. 

Once the PCHA file has 
linked, the window to 
the right will appear. 
Again, navigate within 
the window to the target 
IIAA file, highlight it, 
then click on the 
“Open” button. You 
may also double-click 
on the target file name. 

FETM 4 does not 
acknowledge that the 
file has linked, so this 
screen will remain open 
until you close it. You 
can close this box by clicking on the “X” in the upper right-hand corner. 
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2.2  Rel ink  PCHA/ I IAA F i les  
 

 

 

 

To relink files, click once on the box to the left of “Relink PCHA/IIAA Files” on the Index Tree. 
The following form will appear onscreen: 

 
Note: To change the column widths, simply hold the cursor on the vertical line separating the 
column headings until a double vertical line appears ( ). Holding down the left mouse key, 
move the double vertical line to the left or right to change the column width. To enable the word-
wrap feature (essential for viewing the entire contents of the cell), hold the cursor on the 
horizontal line between the rows on the left-hand side until a double horizontal line appears. 
Then, holding down the left mouse key, move the double horizontal line up or down to change 
the row height and to initiate the word-wrap feature.  

Shaded cells (gray or yellow) cannot be edited, although white cells can be. In this form, only the 
PCHA and IIAA file locations can be changed. You can either change them by clicking twice in 
the PCHA or IIAA File fields and typing the new location directly into the field, or by clicking 
on the “Browse” buttons at the bottom of the page. These will allow you to navigate through your 
pull-down menus to select a new location for the PCHA or IIAA files. Once you have selected a 
new location, click on “Open.” Although no confirmation will appear onscreen, your files will be 
saved in the new location. 

This program area allows you to relink PCHA and IIAA files that have been 
previously linked. You may direct an Analysis Area to use a different PCHA or 
IIAA file, or to use the same files that have been relinked to a different directory. 
You may wish to do this to keep the reference files together in a file folder with the 
Analysis Area files that you will create. 
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The following information from the PCHA file appears in this window. It can only be edited by 
clicking on “Manage Analysis Areas” and “Define Analysis Area” on the Index Tree. 

 Administrative unit number 
 Name of administrative unit  
 Agency name  
 Region  
 State in which administrative unit is located  
 Starting year of NFMAS analysis  
 Ending year of NFMAS analysis  

You can click on the “Close” button at any time to close this window. 

2.3  Unl ink  PCHA/ I IAA F i les  
 

 

 

 

To unlink a set of PCHA and IIAA files, click once on the colored box to the left of “Unlink 
PCHA/IIAA Files.” The following screen will appear: 

 
To delete the FETM 4 link to the file, highlight the target row by clicking on the gray box to the 
left of the “Unit” field. An arrow will appear in the field. Then click on the “Remove” command 
button on the lower left side of the form. 

This program area allows you to delete library information on an existing PCHA or 
IIAA file. This may be necessary to clean up the files associated with a deleted 
Analysis Area, or to delete any “old” PCHA or IIAA files that have been replaced 
by different or updated files. It is primarily a housekeeping function. 
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This action will not delete the PCHA or IIAA files themselves. It will only remove the library 
information stored in the fetm_dat.mdb (Microsoft Access database file) that is used by FETM 4. 

To adjust the column widths, hold the cursor on the vertical line separating the column headings 
until a double vertical line ( ) appears. Holding down the left mouse key, move the double 
vertical line to the left or right to change the column width. 

2.4  Compact  Databases 
 

 

 

To compact a file, click on the colored box or line shown to the left of “Compact Databases” on 
the Index Tree. A dialog box will appear that says, “This operation will take several minutes to 
complete. Do you want to continue?” If not, select the “no” button. To compact files, select the 
“yes” button. This will reveal the following window: 

 
Now navigate to the file you wish to compact, highlight it, then click on the “Open” button in the 
lower right-hand corner. Double clicking on the target file name will also initiate the compaction 
routine. When it is completed, a dialog box with the words “Database compact complete” will 
appear onscreen. Click “OK” to close the dialog box. 

The Analysis Area database file can grow large enough to impair the performance 
of FETM, and may even cause FETM to crash. You should compact the Analysis 
Area databases files frequently to prevent these problems.  
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2.5  Update  FCCs f rom Library  

 

To modify the FCC library or to update the FCC data for the current Analysis Areas, click on the 
colored box to the left of the words “Update FCCs from Library” on the Index Tree. The 
following window will appear: 

 

To update the FCCs in a current (and open) Analysis Area from the FCC library, click on the 
“Update Existing FCCs” button on the bottom of the screen. When the update is complete, a 
message box with the words “FCCs Updated” will be displayed. Only the active Analysis Area 
will be updated. To activate an Analysis Area, see “Select Analysis Area” (see page 22). 

New FCCs may be created inside an Analysis Area and the FCC library file can be updated by 
clicking on the “Add New FCCs” button at the bottom of the screen.  

If the user moves the original setup location of the FCC library file, relocate the file by browsing 
to the new location using the “Browse” button on the right side of the screen. Once you have 
done this, you need to click on the “Save Location” button at the bottom of the screen to relocate 
the files. 

The “Update FCCs from Master FCC Library” window may be closed at any time by clicking on 
the “Close” button or the “X” in the upper right corner. 

 

FETM 4 reads data on the default fuel characteristic classes (FCC) from a separate 
FCC library file (FCCLibrary.mdb) stored in the FETM program directory. A total 
of 206 FCCs are considered to be “system FCCs.” Additional FCCs can be added in 
the “Define FCCs” segment of this manual (see page 59). A description of what 
constitutes an FCC is included in the Glossary.  
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3 Managing Analysis Areas 

 
To access the options within the “Manage Analysis Areas” section of the program, click on the + 
sign to the left of “Manage Analysis Areas” on the Index Tree. The Index Tree will then expand 
to show you additional selections, which are discussed in the following sections. 

3.1  New Analys is  Area  

 

To create a new Analysis Area, click on the colored box to the left of “New Analysis Area” on 
the Index Tree. You must then fill in the white (user-edited) boxes in the window shown below.  

 

 

 

 

 

 

This section of the program allows you to add, copy, delete, or select areas for 
analysis. The Analysis Area forms the basis of the FETM modeling and reports. 
Each Analysis Area is unique as defined by you, the user. An Analysis Area can 
encompass one or several administrative units, or can be made up of parts of one 
or several administrative units. “Manage Analysis Areas” is the main program 
area of FETM 4. Here Analysis Areas are created and modified, scenarios within 
an Analysis Area are created and modified, and scenarios are run and outputs 
generated. 

This section of the program allows you to create new Analysis Areas, including 
name, description, a unique file code, and an associated eco-region. It also allows 
you to identify those specific administrative units that should be included in the 
modeling analysis. 
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These user-required entries include:  

Name Enter any string of characters to describe the new Analysis Area. 

File Code Enter a one to four character code to uniquely identify the new Analysis 
Area (e.g., BW01, 123, yz). 

Eco-Region Select an eco-region code by clicking on the pull-down box on the upper 
right of the screen. If you are unsure about the appropriate Eco-Region, 
mouse click on the “View Eco-Region Map” button located at the 
bottom of the screen to see a map of the eco-regions. You cannot copy 
numbers from the Eco-Region map, so you will need to make a note of 
the appropriate eco-region number to include in the program. 

Description Enter a description of the Analysis Area (optional). 

Option Select the suppression organization option identifier (“Option”) by 
highlighting the appropriate code on the pull-down menu. 

The remainder of the information on the screen is updated from the external PCHA/IIAA files 
using the selection buttons at the bottom of the screen, which are described below.  
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Previous AU/ 
Next AU 

These buttons allow you to move among the administrative units 
selected for a particular Analysis Area. You may only display details 
associated with one administrative unit at a time on this form. Clicking 
on this command button will allow you to view the details associated 
with the next administrative unit included within the Analysis Area. On 
each administrative unit screen you can adjust the suppression 
organization option identifier (“Option”) by selecting the appropriate 
code on the pull-down menu. The associated name will show in the 
“Option” box. 

New AU You can add a new administrative unit to the Analysis Area by 
selecting it from the external files; however, you must fill in the 
Analysis Area name, file code, and eco-region code before adding an 
administrative unit or you will get a “type mismatch” error message. To 
add administrative units to the Analysis Area, click on the “New AU” 
button at the bottom of the screen. The following screen will appear: 

 

 Click on the gray square next to the unit number of the administrative unit you 
wish to include. A black arrow will appear. To select another administrative 
unit, simply repeat this process and double click on a different administrative 
unit number. You may continue to add administrative units to the Analysis Area 
using this approach. When you are finished, exit this screen by selecting the 
“Close” button. 

Delete AU You can remove an administrative unit by selecting this button. The 
administrative unit on the screen at the time is the administrative unit that will 
be deleted. Use the “Previous AU” and “Next AU” buttons to scroll through the 
administrative units until you find the one you wish to delete. Then click the 
“Delete AU” button. A dialog box will appear that says, “Are you sure you want 
to delete administrative unit # from the Analysis Area?” Click the “Yes” button 
to delete. Click “No” to return to the previous screen. 
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The following information will appear onscreen from the PCHA/IIAA files once you have 
selected the administrative units to be included. These fields cannot be edited on this screen. 

 Administrative unit number 
 Administrative unit name  
 Administrative unit agency  
 Administrative unit region  
 Analysis Area acres  
 Administrative unit state 
 Start year for PCHA 
 End year for PCHA 
 PCHA file name and path associated with this administrative unit number (see 

“Managing External Files/Load PCHA/IIAA Files,” page 11) 
 IIAA file name and path associated with this administrative unit number  
 List of Fire Management Zone (FMZ) numbers and descriptions 

Once you have selected all of the administrative units you want to associate with this Analysis 
Area, you will need to fill in the following areas. The FMZ information should be available from 
your organization’s fire planning staff. It is used by FETM 4 to compute the breakpoint average 
rates of spread under “Define Expected Fire Size” on the Index Tree (see page 83 for further 
discussion). 

 
Total FMZ Acres Enter the sum of all FMZ acres within the administrative unit(s). 

AA FMZ Acres Enter the acres found within the Analysis Area and the FMZ. The number 
of acres within the Analysis Area and FMZ may be less than the total 
FMZ Acres if the Analysis Area is smaller than the administrative unit. 
This uses the rate of spread from the IIAA program to determine area 
weighting. 

AA FMZ Fires Enter the number of fires per year found within the Analysis Area and the 
FMZ. The number of fires within the Analysis Area and FMZ may be 
less than the total FMZ fires if the Analysis Area is smaller than the 
administrative unit. This uses the rate of spread from the IIAA program to 
determine frequency weighting. 

Update FCCs 
from Library 

Selecting this button performs the same function as described in “Manage 
External Files/Update FCCs from Library.” It is provided here for 
convenience. 
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3.2  Copy Analys is  Area  
 

 

 

To copy an Analysis Area, simply click on the colored box or text line to the left of “Copy 
Analysis Area” on the Index Tree. The following screen will appear: 

 

Ana lys is  Area  to  Copy   

Name Under “Analysis Area to Copy” you may select the name of the Analysis Area 
you wish to copy by clicking on the pull-down arrow, then highlighting the 
appropriate Analysis Area. 

 

This program area allows you to copy all the data from one Analysis Area to 
another. This allows you to make relatively simple changes to an Analysis Area 
without requiring you to re-enter all of the data. 
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New Ana lys is  Area  

 
Name Further down the screen, in the “New Analysis Area,” enter the name of the new 

Analysis Area you wish to create from the copied material. 

File Code Enter a one- to four-character code for the new Analysis Area (letters or 
numbers) 

Descriptio
n 

Enter additional descriptive information about the new Analysis Area in this field 
(optional). 

Copy When you have completed the form and are ready to copy the Analysis Area, 
click the “Copy” button. The “Copy” button is disabled until the form has been 
filled out. 

Close The “Close” button may be clicked at any time to exit this form, or you can click 
on the “X” in the upper right corner. 

3.3  Dele te  Analys is  Area  
 
 

 

 
To delete an Analysis Area, click on the colored box to the left of “Delete Analysis Area” on the 
Index Tree. This will reveal a list of all Analysis Areas currently in the system. To delete an 
Analysis Area, simply click on the gray box to the left of the Analysis Area that you wish to 
delete, and then click the “Delete” button on the lower left-hand side of the form. If you decide to 
rethink your decision to delete an Analysis Area, simply click on the “Cancel” button to return to 
the Index Tree. 

3.4  Se lect  an  Analys is  Area  
 

 

 

 

Previously created Analysis Areas may be opened (activated) by clicking on the folder icon or 
text line to the left of “Select Analysis Area” on the Index Tree. To show the list of available 
Analysis Areas, click on the + sign immediately to the left of “Select Analysis Area.” This will 

This program area allows you to remove Analysis Areas that are no longer in use. 
However, it is important to remember that deleting an Analysis Area is 
PERMANENT. There is no possibility of recovering data once the Analysis Area has 
been deleted. Proceed with caution! 

It is within specific Analysis Areas that the most important work of FETM is done. 
This is the area where the model analyzes the tradeoffs between wildland fire and 
fuel treatment alternatives, analyzes the economic costs and benefits of alternative 
treatment programs, and forecasts the impacts of future wildland fires on the 
ecosystem within a defined Analysis Area. 
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change the + sign to a – sign and expand the Index Tree to show all available Analysis Areas. 
Click the – sign to reverse the process.  

The Analysis Area used in the last FETM 4 session will be automatically opened. To select 
another Analysis Area, simply click on the desired folder icon. A dialog box that reads “Analysis 
Area has been successfully opened” will be shown on the screen once the Analysis Area has been 
opened. Click “OK” to continue. 

Because this section of the program is the most complex, the following sections of the manual 
have been broken out with dividers to aid the user in finding specific information. 
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3.5  Def ine  Analys is  Areas 
Once an Analysis Area has been opened, the first item on the Index Tree on the left-hand side is 
“Define Analysis Area.” This program area lets you review (and modify if necessary) the 
Analysis Area assumptions specified when the Analysis Area was created. The field definitions 
are the same as those described in “Managing Analysis Areas/New Analysis Area” (see page 17). 
Any changes made to these fields are automatically saved in FETM 4. 

If the list does not appear on the Index Tree under the Analysis Area, click on the + sign 
immediately to the left of the folder name.  
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3.6  Manage Der ivat ive  Fuel  Models  (DFM)  

 

Derivative Fuel Models (DFMs) are fuel models that are used in predicting fire behavior (e.g., 
rate of spread) in FETM 4. A total of 284 DFMs currently exist in FETM 4. These 284 DFMs 
have been derived from the 20 parent NFDRS fuel models. Each DFM is identified by a unique 
three-character code. The first letter in the code is the parent NFDRS fuel model (A through L, N 
through U). The second character is the loading classification. Loading options include L (low 
loading; loading is 30% lower than parent NFDRS fuel model); M (moderate loading; same 
loading as parent NFDRS fuel model); and H (high loading; loading is 30% higher than parent 
NFDRS fuel model). The last character is an arbitrary number that represents a unique 
combination of wind reduction factor (0.2, 0.3, 0.4, 0.5) and shading condition (shaded, 
unshaded).  

Def ine  DFMs  

Click on “Define DFMs” on the Index Tree to open the DFM data table. The DFM data table 
contains all the information that characterizes the DFMs for the selected Analysis Area. It 
comprises both raw entered data and 
values computed using algorithms 
embedded in FETM 4. 

Click on the “Define Derivative Fuel 
Models (DFM)” node to expand the 
Index Tree, as shown to the right: 

This program area computes the basic fire behavior parameters (e.g., rate of spread) 
used elsewhere in the FETM program. In this area, you may view the Derivative 
Fuel Model (DFM) characteristics, compute weather-based outputs and breakpoint 
rates using the Historical Analysis-Initial Attack (HAIA) model, define the spread 
component breakpoints between each of four fire weather classes, and specify the 
mean fire frequency in each of the fire weather classes. Much of the information in 
this section of the program is derived from other program areas (such as “Initiate 
HAIA”) and does not require direct user input in this section. 



 

  26

Click on the “Define DFMs” node to display the following spreadsheet on the right-hand side of 
the window: 

The tabs listed across the top of the Derivative Fuel Model Data Table are explained in greater 
detail below. The current (active) tab will have a matchstick icon on it, and will be located in the 
first row, on the left-hand side. Use the horizontal and vertical scroll bars to view the entire sheet. 

Blank fields within these spreadsheets indicate either that the DFMs have not been processed 
through HAIA (see “Initiate HAIA”), or that the fire weather classes have not been defined (see 
“Define Weather Class”). 
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Fuel Model 
Characterization 

Click this tab to reveal a list of fuel models and their characteristics 
(non-editable; data imported from “haia2000.new” file), including: 

 Derivative Fuel Model Code 
 Parent Fuel Model Name 
 Loading Class 
 Shading 
 Wind Reduction Factor 
 Wood, Fuel, and Herb Loading Characteristics 

Danger Rating–
Spread Component 
(SC) 

Click this tab to reveal the HAIA-computed spread component 
values by fire weather class (Low, Moderate, High, Extreme). These 
values cannot be edited. 

Danger Rating–
Energy Release 
Component (ERC) 

Click this tab to reveal the HAIA-computed energy release 
component values by fire weather class (Low, Moderate, High, 
Extreme). These values cannot be edited. 

Danger Rating–
Burning Index (BI) 

Click this tab to reveal the HAIA-computed burning index values by 
fire weather class (Low, Moderate, High, Extreme). These values 
cannot be edited. 

Danger Rating–
Ignition Component 
(IC) 

Click this tab to reveal the HAIA-computed ignition component 
values by fire weather class (Low, Moderate, High, Extreme). These 
values cannot be edited. 

Surface Fuel 
Moisture 

Click this tab to reveal the fuel moisture content of 10-hour and 
1,000-hour time-lag fuels by fire weather class (Low, Moderate, 
High, Extreme). 

Fire Behavior–Rate 
of Spread (ROS) 

Click this tab to reveal the rate of spread of fires by fire weather 
class (Low, Moderate, High, Extreme). 

Fire Behavior–
Fireline Intensity 

Click this tab to reveal the fireline intensity values by fire weather 
class (Low, Moderate, High, Extreme). 

To change and save the column widths, hold the cursor on the vertical line separating the column 
headings until a double vertical line (  ) appears. Holding down the left mouse key, move the 
double vertical line to the left or right to expand or contract the column width. When the desired 
width is attained, click on the “Save Column Widths” button to save the current setting. 

To close this form at any time, click on the “Close” button or the “X” in the top right-hand 
corner. 
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I n i t i a te  HA IA  

 
 
L o c a t i n g  N F M A S  P C H A  a n d  I I A A  F i l e s  

See “Link PCHA/IIAA Files” on page 11 for a description of 
how to link (locate) and relink PCHA and IIAA files. Before 
PCHA and IIAA files can be assigned to an Analysis Area, 
they must first be made available to FETM 4 through “Link 
PCHA/HAIA Files” Index Tree. 

 
I d e n t i f y i n g  N F M A S  P C H A  a n d  I I A A  F i l e s  f o r  a n  A n a l y s i s  
A r e a  

When defining an analysis area, you will need to specify which administrative units and PCHA 
and IIAA files will be used for the Analysis Area. This is done under “Define Analysis Area” on 
the Index Tree (see page 24). You must also select a fire program option from IIAA for HAIA to 
use to calculate the breakpoint rates-of-spread values. 

 

FETM 4 uses a custom adaptation of the PCHA (PCHA99) and IIAA (IIAA99) 
models, called the Historical Analysis-Initial Attack (HAIA) model. The purpose 
of the HAIA program is to gather and pre-process weather and fire occurrence 
data from the NFMAS IIAA and PCHA .mdb files. The pre-processed weather 
data are NFDRS indices to facilitate the generation of percentile weather within 
FETM. The pre-processed fire occurrence data are the breakpoint rates-of-spread 
by NFDRS derivative fuel model for the fire size class breaks 0.25 acres, 10 acres, 
100 acres, 300 acres, and 1,000 acres. These breakpoint rates-of-spread values are 
used in FETM 4 to aid in the construction of rate-of-spread versus final fire size 
curves for final fire sizes less than 1,000 acres.  

User manuals for both the PCHA and IIAA programs are available from the USFS 
Fire Applications Support website at:  

www.fs.fed.us/fire/planning/nist 

Click on “Distribution” at the bottom of the web page, then select “User Guide” 
and you will find user guides for IIAA and PCHA that you can download. 
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U s i n g  t h e  H A I A  P r o g r a m  w i t h i n  F E T M  4  

To execute HAIA, click “Initiate HAIA” on the Index Tree. The program will transfer to HAIA 
and a blank, gray-colored screen will appears. This is similar to the screen that appears after 
initiating PCHA99. The program is menu-driven, so you must select from the menu to continue. 
The steps required to execute HAIA must be done in a particular order, which corresponds to 
following the pull-down menus shown below from left to right and completing the tasks shown 
on each pull-down menu from top to bottom. Each of these menus is discussed in more detail in 
the following sections. 

 

 

An outline of the tasks you must complete to execute HAIA follows: 

Import weather data from PCHA: 
 Import weather stations 

 Import weather stations 
 Prioritize duplicate observations 
 Years to import 
 Import weather observations 

 Assign prioritization for multiple weather stations in Analysis Area 
 Assign years to import for each weather station 
 Import weather and fuel moisture data 
 Import fire dates from PCHA 

Edit values: 
 Fire season start and stop dates 
 Calibrated fireline production rates 
 Fuel model fireline production rates 
 Fuel model-specific site parameters 
 Select fuel models to run 
 Assign percentage of each representative location (RL) that lies within the Analysis Area 

Assign Net Value Change (NVC): 
 Assign stumpage values by timber species 
 Assign timber table parameters for mature timber 
 Assign timber table parameters for immature timber 
 Assign NVC for forage species 
 Assign NVC for other non-timber, non-forage paramount values 
 Calculate weather-based outputs 
 Calculate breakpoint rates of spread 
 Exit HAIA and return to FETM 4 
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File  

 
 
View Action History 

 

When you select “View Action History” on the “File” menu, a table 
with two tabs — “Import” and “Edit/Calculate” — will appear, as 
shown in the following two screens. The date and time that a 
function was last performed is shown. This allows the user to check 
if all necessary functions have been performed as well as when they 
were performed. Because this menu is primarily informational, it 
does not require you to follow the strict order of the other menus.  

 

 
 
 
 
 
 
 

The File menu, shown at right, allows you to view a 
table that shows when the functions performed within 
HAIA have occurred. This menu is also used to exit 
from the HAIA program and return to FETM 4. 
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Exit 

 

Click on “Exit” on the “File” menu to return to FETM 4. The 
following dialog box will appear onscreen, “Do you want to 
recalculate Fire Behavior values? The process may take a while.” If 
new calculation functions (Weather-Based Outputs or Breakpoint 
Rates-of-Spread) have been performed, select “Yes.” 

 
Import 

 
Weather (PCHA)  

 

 

Weather observations need to be imported to HAIA from PCHA. 
Before the actual import can occur, you will need to define which 
weather stations to import data from, prioritize weather observations 
from stations that are found in more than one administrative unit 
PCHA file, specify the years of data to import, and select those 
specific weather observations to import. The “Weather (PCHA)” 

The following information is imported into HAIA 
using this menu: weather observations, fire 
occurrence dates, information on fire production 
resources at the fire program option used in the 
analysis, fire suppression costs, and economic fire 
effects information. Each of these is discussed in 
more detail below. 
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menu is shown below, as well as an explanation of each menu item.  

 
 

 Import Wx  
Stations  

From the main HAIA screen, select “Import,” “Weather (PCHA),” 
and then “Import Wx Stations.” The screen shown below or a similar 
screen will appear. If more than one administrative unit is included 
in an Analysis Area, data may be extracted from each administrative 
unit’s PCHA file. In that case, multiple paths will be shown. Click 
on the box to the left of each file from which the import of weather 
stations is desired. Then click on the “OK” button. To return to the 
previous screen without selecting a path, click on “Cancel” or the 
“X” in the upper right corner. 
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 Prioritize 
Duplicate 

Observations  

From the main HAIA screen, select “Import,” “Weather (PCHA),” 
and then “Prioritize Duplicate Observations.” Each weather station 
that has been imported to HAIA is listed in rows, with each 
administrative unit in the Analysis Area shown in columns (see 
following screen). If the same weather record is found in more than 
one administrative unit's PCHA database, you will need to prioritize 
them. A higher number indicates a higher priority. If more than one 
administrative unit is specified in the Analysis Area, then a separate 
column for each administrative unit will appear in the form. The 
weather station priorities need to be assigned across all of the 
administrative units. There is no identification of which weather 
stations are associated with each administrative unit; therefore, the 
user should assume that all weather stations are found in all 
administrative units unless they have independent information about 
the location of the stations. 

If all stations in all of the administrative units have equal priority, 
than the same number (it doesn’t matter what the number is in this 
case) should be entered in the space next to each six-digit weather 
station number.  
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 Years to Import  From the main HAIA screen, select “Import,” “Weather (PCHA),” 

and then “Years to Import.” The screen shown below will appear. 
Click in the appropriate cells for the weather stations and years you 
want to import. An “X” will appear in the selected boxes. You can 
select all years for all stations by clicking on the “Fill All” button. 
You can also clear the screen of all checked cells by clicking on the 
“Erase All” button. Once you have selected the years to be included, 
click on “OK” or click “Cancel” or “X” to return to the previous 
screen. 

 
 Import Weather 

Observations  
From the main HAIA screen, select “Import,” “Weather (PCHA),” 
and then “Import Weather Observations.” The screen shown below 
will appear. Click on each weather station you want to import. 
Weather stations selected for import will be highlighted in blue. 
Click on the “OK” button to start the import function or click 
“Cancel” to return to the previous screen. 
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Import Fire Dates 
(PCHA)  

From the main HAIA screen, select “Import,” and then “Fire Dates 
(PCHA).” The screen shown below will appear. To import fire dates 
from the listed files, select “OK.” To return to the previous screen 
without importing the fire dates, select “Cancel” or “X.”  

HAIA will import the following information from PCHA: 
administrative unit identifier, the Fire Management Zone (FMZ) and 
the discovery date for all fires since 1970 for which data are 
available. HAIA uses these fire dates to determine days when fires 
happened historically. This information is used to support 
calculation of fire frequency by percentile fire weather class (low, 
moderate, high, and extreme). 
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IIAA Import  

 

 

Select “IIAA Import” from the “Import” menu. The screen shown 
below will appear. Select the appropriate boxes for the IIAA files 
you wish to import in the “Import?” column, then type the three 
letter code for the FBD file that you want to use. The following 
information will be imported from each Administrative unit’s IIAA 
.mdb file. 

 Average Acre Costs  
 Acres Burned by Rep Loc by Fire Intensity Level (FIL) for 

the Defined Fire Program Option 
 Information on Production Resources Available in the 

Defined Fire Program Option 
 Net Value Change Data  
 Percent of Fire Frequency by FIL for each FMZ 
 Percent of Fire Frequency by Rep Loc for each FMZ 
 Unit Mission Costs 

Some of this information is used to provide cost and economic 
effects information for FETM 4, as well as to develop breakpoint 
rate-of-spread values to support construction of the rate-of-spread 
versus final-fire-size values. 

It is possible to import data for one FBD (“CAL” in this case) and 
then for another FBD later. Both will be retained in the database 
unless you check the box that says, “Delete information previously 
imported from IIAA.” Checking this box will clear the previous 
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FBD-related information before importing the next set of data.  
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Edit 
 
 
 
 
 
 
 
 
 
 
Fire Season Start/ 
Stop Dates  

Percentile weather is calculated using weather and fire occurrence 
data for a defined fire season. To allow this, the start and stop dates 
for the fire season must be designated, as well as those years to be 
included in the analysis. To define the fire season, from the main 
HAIA screen select “Edit” and then “Fire Season Start/Stop Dates.” 
The screen shown below will appear. Enter the appropriate 
information, then click on “OK.” You can also click on “Cancel” or 
“X” to return to the previous screen. 

 

 
Calibration 
Production Rates 

Within IIAA, the fireline production rates used at calibration are 
contained in the Master Resource Table (MRT), which can be 
viewed in the “Database Browser” discussed later in this section. On 
the MRT, Default Production Rates menu in IIAA, the fireline 
production rate for a one-person handline crew is shown on the first 
row. Examples of the IIAA menu and screen follow:  

 
 
 
 

The values shown on the menu to the right need to be 
defined, verified, or edited to facilitate outputs from 
HAIA. Specific directions for each menu area are given 
in the following sections.  
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  In HAIA, a default set of fireline production rates for a one-person 
handline crew will need to be input by FMZ. To do this, from the 
main HAIA screen select “Edit” then “Calibration Production 
Rates.” The screen shown below will appear. Enter the one-person 
handline crew production rate in the third column, “CAL PRate.” 
This should be the same rate that was used in the IIAA program 
during calibration. Once you have finished entering the production 
rates, select “OK.” To return to the previous screen, select “Cancel” 
or “X.” 

 

Fuel Model  
Production Rates 

The fireline production rates used in the IIAA have been modified 
for use in HAIA by the factor shown below. 

1-person hand-line crew  
fuel model production rate  Fireline production 

rate used for a 
resource in HAIA 

 
= 

Fireline 
production rate 
for a resource 

in HAIA 

 
* 

1-person hand-line crew  
calibration production rate 

 You can either enter a one-person hand-line crew production rate for 
each derivative fuel model or use the default production rates that 
are provided. These values are entered by NFDRS slope class. 
Fireline production capability varies by derivative fuel model and by 
slope class. 
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To perform this function, from the main HAIA screen select “Edit” 
and then “Fuel Model Production Rates.” The screen shown below 
will appear. Click on the black arrow to the right of the “Admin. 
Unit” cell, then select an administrative unit from the pull-down list. 
The default production rates will appear in the cells. To accept the 
default rates, click on the “Use Defaults” button on the bottom right 
of the screen. The defaults will be accepted. Click on “OK” to return 
to the previous screen. To change the default rates, click in the 
appropriate cells and replace the default rates with the production 
rates that you wish to use. Then click “OK.” The changed production 
rates will be saved and you will be returned to the previous screen. 
To return to the previous screen without changing the production 
rates, click on the “X” in the upper right corner. 
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Fuel Models/Sites 

 

 

 

 

Fuel Model  
Parameters 

HAIA will use the fuel model and site parameters defined here to 
calculate fire behavior. HAIA contains the 20 NFDRS fuel models 
plus 264 derivative NFDRS fuel models. These fuel models should 
not be changed. Additional derivative NFDRS fuel models can be 
defined in HAIA. Custom fuel models should be developed by staff 
with advanced training in this subject because unrealistic NFDRS 
indices can result in fuel models with an unrealistic set of input 
parameter values. 

To run fuel model and site parameters, from the main HAIA screen 
select “Edit” then “Fuel Models/Sites.” The screen shown below will 
appear. Please note that it has two tabs. The first, Fuel Model  
 
Parameters, is explained here. The second, Site Parameters, will be 
explained below.  

 

 The following information is available on the “Fuel Model 
Parameters” tab: 

ID—The fuel model ID code—a combination of up to three letters 
and numbers. 

Name—The name of the fuel model. 
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SA Vol—The surface area-to-volume ratio for each of the fuels listed 
below measured in square feet to cubed feet (ft2/ft3).  

 1-hour fuel loading (1-hr) 
 10-hour fuel loading (10-hr) 
 100-hour fuel loading (100-hr) 
 Live woody fuel loading 
 Live herbaceous fuel loading (herb) 

Surface area-to-volume ratios can range from 109 to 4,000 ft2/ft3. 
Definitions of each of the individual fuels are found in the Glossary. 

Loads—The fuel loading (up to 30.49 tons per acre) for each fuel 
type.  

Depth—The average depth of the surface fuel (0.05 to 6.00 feet). 
Fuel bed depth is sometimes called fuel bed bulk depth. It should not 
be confused with the average high particle depth, which is an output of 
the planar intercept dead down woody fuel sampling process. 

Heat Content—The dead and live fuel heat content in British 
thermal units (Btu) per pound of fuel (Btu/lb). This is the amount of 
heat energy contained in a unit of fuels, ranging from 6,000 to 12,000 
Btu/lb. The most commonly used heat content is 8,000 Btu/lb. 

Herbs—This indicates whether the live herbaceous fuel loading 
(herb) category to the left is annual or perennial. 

Shaded—The NFDRS calculations assume that fuels are unshaded 
from the sun because the weather observations used in the NFDRS 
calculations are taken in the open. This box is checked if the fuel 
model is for shaded conditions (greater than 50 percent shading from 
the sun by vegetation). 

Extinction Moisture—The dead fuel moisture of extinction 
(from 5 to 100 percent). This is the maximum moisture content of the 
dead fuels at a predictable steady state rate of fire spread, if attainable. 
If the dead fuel moisture is greater than this value, a predictable steady 
state rate of fire spread cannot be predicted even though the fire may 
continue to smolder and spread. 

SC Max—The Spread Component Maximum (SCM), which can 
range from 1 to 301. This is the highest expected rate of spread from 
the fuel model. It is used to help calculate the NFDRS Ignition 
Component index. 

NFDRS Fuel Model—The derivative NFDRS fuel model(s) that you 
wish to run. There are 284 different fuel models to choose from in 
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HAIA.  

Wind—The reduction factor used in the NFDRS to calculate the 
midflame wind speed from the 20-foot wind speed is shown in the 
FIRDAT cell. The wind reduction factor to be used in FETM 4 is 
shown in the FETM cell. The FETM 4 reduction factor is less than the 
NFDRS factor (FIRDAT) to reflect more realistic values rather than 
the worst-case values.  

 
 

 Site Parameters  The “Site Parameters” tab is shown below. Four site parameters need 
to be provided for each fuel model. These are: 

Weather Station—Click on the black arrow to the right of the 
cells under “Weather Station” to enter the weather station you wish 
to specify. You will need to specify at least one weather station for 
HAIA to obtain a weather observation. However, because a weather 
observation may not be available from the first priority weather 
station, you may want to select additional weather stations. You may 
select up to five. 
Slope Class—Select the NFDRS slope class that is most 
representative of where the fuel model will occur by clicking on the 
corresponding radio button.  
Aspect— Select the aspect (direction that the slope faces) most 
representative of where the fuel model will occur by clicking on the 
corresponding radio button.  
Position on Slope—Select the position on the slope that is 
most representative of where the fuel model will occur by clicking 
on the corresponding radio button.  
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Copy Site 
Characteristics to 

ALL Fuel Models 

If you want the site parameters to be applied to all of the defined 
NFDRS and derivative fuel models, click on the “Copy Site 
Characteristics to ALL Fuel Models” button at the bottom of the 
“Site Parameters” tab. A dialog box that says, “OK to copy site 
characteristics to ALL fuel models?” will appear. If you wish to 
continue, select “Yes.” If you wish to return to the “Site Parameters” 
tab, select “No.” 

 

Fuel Models to Run  This menu item allows you to select those fuel models for which fire 
behavior will be calculated by HAIA. It is critical that fire behavior 
be calculated for all NFDRS and derivative NFDRS fuel models that 
are assigned to any FCC that is to be used in an Analysis Area. 

From the main HAIA screen select “Edit” then “Fuel Models to 
Run.” The screen shown below will appear. Click on the ID codes 
for those fuel models you wish to run. Selected fuel models are 
highlighted in blue.  

You can select all of the listed fuel models by clicking on the “Select 
All” button on the bottom right. You can remove the highlighting 
from all of the ID codes by clicking on “Clear All” at the bottom left 
of the screen. Once you have highlighted the fuel models that you 
want to include, you can return to the previous screen by clicking on 
the “X” in the upper right corner of the screen. 
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Representative 
Locations in Analysis 
Area  

This information is used by HAIA in the calculation of the fire 
suppression and net value change values that will be used in the 
Analysis Area. You will need to use GIS or other means to obtain 
the acreage information from which the percentages can be 
determined.  

To enter the percentage of each representative location found in the 
Analysis Area select “Edit” then “Rep Locations in Analysis Area.” 
For each administrative unit, enter the percentage of each 
representative location found in the Analysis Area. Then go on to the 
next step described below. 
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Net Value Change 
(NVC) 

If you want FETM 4 to project timber Net Value Change values for 
selected FCCs, you will need to develop an NVC table for those 
FCCs. You are encouraged to consult the National Fire Management 
Analysis System (NFMAS) IIAA User’s Guide for specific defini-
tions and information regarding how NVC values are developed. 
The user’s guide is available from the U.S. Forest Service Fire 
Applications Support website at:  

www.fs.fed.us/fire/planning/nist 

Click on “Distribution” at the bottom of the web page, then select 
“User Guide” and you will find user guides for IIAA and PCHA that 
you can download. 

This User’s Guide assumes that you have a working knowledge of 
the NFMAS analysis processes. All of the processes used in IIAA to 
develop NVC tables are repeated in HAIA to allow you to generate 
NVC values if they have not been developed in the IIAA .mdb. The 
Import, Import IIAA menu item, described earlier in this section, 
populates the HAIA .mdb with all of the NVC table information 
from the IIAA .mdb for each administrative unit. 
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 To generate an NVC 
table, from the main 
HAIA screen select 
“Edit” then “NVC.” 
The submenu shown 
to the right will 
appear. The items 
included in the 
submenu are 
described in greater 
detail below. 

 
 Timber Species  

and Prices  
Timber stumpage values have been imported from the IIAA. An 
example is shown below. If there is no commercial timber in the 
Analysis Area, nothing will be listed on the table. 

 
 
 
  
 
 
 
 

 Mature Timber  The mature timber table values have been imported from the IIAA. 
An example is shown below. You can select the entries for each 
mature timber table defined. Again, if there is no commercial timber 
in the Analysis Area, as shown in the sample screen, nothing will be 
listed on the table. The inset screen is an example of an Analysis 
Area with commercial timber information 
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 Immature Timber  The immature timber table values have been imported from IIAA. 
An example is shown below. You can select the entries for each 
immature timber table defined for the species/size class definition to 
review or enter the percent affected by FIL. In the bottom left 
corner, you can also specify the percent of the FCC that is in each of 
the Poles and Seedling/Saplings groups. 
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 Forage  The forage values and expected changes by FIL have been 
imported from IIAA. An example is shown below.  

 
 

 
 

 Other Resources  HAIA allows you to consider the values of additional, or “other,” 
resources in your calculations. These include water, fish, wildlife, 
and recreation. These values are imported into tab 4, shown in the 
screen below, from IIAA for varying fire intensity levels. Tabs 1 
through 3 allow you to define these NVC values if they were not 
developed in the IIAA .mdb. The user is encouraged to consult the 
NFMAS IIAA Users’ Guide for specific definitions and information 
on how these NVC values are developed.  

To define other resources, from the main HAIA screen select 
“NVC,” then “Other Resources.” To use the information imported 
from IIAA and presented on tab 4, select the “Imported Values 
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Two major processes are calculated within  
HAIA—weather-based outputs and breakpoint  
rates of spread.  

Under “Weather-Based Outputs,” FETM 4 calculates the NFDRS indices Spread 
Component, Energy Release Component, Burning Index, and Ignition Component. 
The values are generated to aid in the determination of percentile weather by 
NFDRS fuel model and each derivative NFDRS fuel model.  

The breakpoint rates-of-spread by NFDRS derivative fuel model are for the fire 
size class breaks of 0.25 acres, 10 acres, 100 acres, 300 acres and 1,000 acres. 
These breakpoint rate-of-spread values are used in FETM to aid in the construction 
of rate-of-spread versus final fire size curves for final fire sizes of less than 1,000 
acres. 

Shown on Tab 4” radio button at the bottom right of the screen. To 
define other resources manually, select the “Values on Tab 3 from 
Manual Entries on Tabs 1 & 2” radio button at the bottom left of the 
screen, then enter the information indicated on tabs 1 and 2.  

To return to the previous screen, click on the “X” in the upper right 
corner.  

 

 
Calculate 
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Weather-Based 
Outputs  

To calculate the weather-based outputs, from the main HAIA menu 
select “Calculate” then “Weather-Based Outputs.” A list of the fuel 
models will appear, as shown below. To calculate the outputs, click 
on “OK.” Once the outputs have been calculated, a dialog box with 
the following message will appear, “NFDRS Calculations have been 
completed. The resulting values will be save in the Interval Wx table 
in the .mdb and can be viewed using the “Database Browser,” which 
is found under the “Help” menu item. To return to the previous 
screen, press “OK.” The key to the NFDRS Index in the Interval Wx 
table is 1=Spread Component, 2=Burning Index, 3=Energy Release 
Component, and 4=Ignition Component. To return to the previous 
screen without calculating the outputs, select “Cancel.”  

 
 
Breakpoint  
Rates-of-Spread  

To calculate the breakpoint rates of spread (BROS), from the main 
HAIA menu select “Calculate” then “Breakpoint Rates of Spread.” 
Check the box at the bottom of the screen if you want to save the 
results by representative location (RL) or fire intensity level (FIL), 
then click on “OK.” It may take quite a while for your computer to 
process these calculations. The BROS screen is shown below.  

The breakpoint rates of spread are saved in the BROS table in the 
.mdb and can be viewed using the “Database Browser,” which is 
included on the “Help” menu and discussed in greater detail below.  

To return to the previous screen without calculating these rates, click 
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on “Cancel.” 

 
 
Help 
 

 
 
Datebase Browser The database browser allows you to view any of the NVC tables 

included in HAIA. To access it, from the main HAIA screen, select 
“Help,” then “Database Browser.” The screen shown below will 
appear. Click the name of the table you wish to see in the list on the 
left side of the screen. The information and column headings 
included will vary according to the table selected.  

You can return to the previous screen by clicking on the “X” in the 
upper right corner of the screen. 

 

 

The Help menu has two menu items, as shown to the right. 
The “Database Browser” allows you to view any table in the 
HAIA database (.mdb). The “About” menu item shows a 
screen with information about the version of HAIA that you 
are running. 
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About HAIA This screen provides information about the version of HAIA that is 

running, including the version number and developers. 

To obtain this information, from the main HAIA screen select 
“Help,” then “About.” The screen shown below, or a similar screen, 
will appear. 

You can return to the previous screen by clicking on the “X” in the 
upper right corner of the screen. 
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R e c a l c u l a t e  F i r e  B e h a v i o r  V a l u e s  

Once the weather-based outputs and breakpoint rates of spread have been calculated in HAIA, 
the values are immediately populated in the DFM table (see “Define DFMs”). To recalculate the 
maximum fire rate of spread (used in the calculation to determine fire size and type), the user is 
prompted with the following message upon returning to FETM 4 from HAIA: 

 

 

 

 

Clicking “Yes” will cause the fire behavior values to be recomputed, and the new values will be 
stored in the DFM data table. Clicking “No” means that the new fire behavior values will not be 
recomputed or stored in the DFM data table. In that case, the previous values will be retained in 
the DFM data table. 

Def ine  Wea ther  C lass  Da ta  

 
Click on the “Define Weather Class” node on the Index Tree to reveal the following cumulative 
frequency diagram for the specific derivative fuel model. The diagram shows the cumulative 
frequency of time (y axis) for different spread component values (x axis).  

The purpose of this program area is to establish the Spread Component ranges that 
will be used to characterize the four fire weather classes—low, moderate, high, and 
extreme—in FETM 4.  
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You must input the following information on this screen: 

Select Fuel 
Model 

Select the appropriate fuel model from the drop-down list. To determine 
the characteristics of a particular fuel model, go to the “Define DFMs” 
section of the program (see specific instructions on page 25) 

Spread 
Component 
Cumulative 
Frequency 
Range 

This range is used to characterize each weather class. Enter the upper end 
of each range; the lower end of each range will be automatically adjusted. 
You may review or edit the weather classes by clicking on the “Show 
Weather Class Data” button on the bottom left of the screen. More detailed 
instructions for editing the weather classes are shown below. 

The following information will be entered from the PCHA file previously selected and cannot be 
edited here. For more information on selecting PCHA files, please refer to the “Manage External 
Files” section of this manual. 

 Fire season starting month and day  
 Fire season ending month and day  
 Starting year of weather record  
 Ending year of weather record  
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The following information that appears on this screen is calculated by FETM 4 and cannot be 
edited here. It is based on the user-selected Weather Classes and Spread Component Cumulative 
Frequency Range.  

Percentage of Time in 
Range 

The percentage of time in range occupied by each weather 
class is calculated by subtracting the lower frequency value 
from the upper frequency value. For example, 90%-
16%=74% would be characterized as moderate fire weather. 

Spread Component Range This line presents the spread component values found in 
each cumulative frequency range. 

Median Spread Component This value represents the median (50th percentile) spread 
component found in each cumulative frequency range. 

Click on the “Save” button to save any changes you have made to the spread component ranges.  

Click on the “Close” button or “X” at any time to close the form. 

S h o w  W e a t h e r  C l a s s  D a t a  

To review or edit the weather classes used in this form, click on the “Show Weather Class Data” 
button, shown at the lower left of the previous screen. The following screen will appear: 
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The default data in this table are based on the HAIA data calculated previously in this program. 
These are the averages of the weather records for all of the fires included under “Number of 
Observations” on the previous screen, and are based on the average spread component range for 
each class defined. For more information on HAIA, refer to the “Initiate HAIA” section of this 
manual (see page 28). 

The fields on this form are explained in greater detail below. 

SC Subset (Range) The SC (Spread Component) Subset is used to characterize all of 
the other fields on this form. By default, the “range” is simply the 
median spread component from the previous form. However, you 
may edit this range to any starting and ending values as long as 
they lie within the ranges specified in the “Spread Component 
Range” field found near the bottom of the previous form. If the 
range is modified, you must retrieve additional fuel data and 
recalculate the fire danger rating parameters by clicking on the 
“Retrieve Fuel Data” and then the “Recalculate Indices” button at 
the bottom of this screen. 

Number of 
Observations 

This is the number of daily weather records that lie within the 
specified SC range. This number is taken from the weather records 
imported from the administrative unit-specific PCHA database 
files using HAIA. 

Fuel Moisture 
Percentages 

This is the arithmetic average of fuel moisture values for days 
falling within the SC range of values for each fire weather class. 
Note that the user can edit these values. However, if you change 
these values, you must recalculate the fire danger rating 
parameters by clicking on the “Recalculate Indices” button. 

Wind Speed This is the arithmetic average of wind speed for days falling within 
the SC range of values for each fire weather class. Note that the 
user can edit these values. However, if you change these values, 
you must recalculate the fire danger rating parameters by clicking 
on the “Recalculate Indices” button. 

Fuel Temperature This is the arithmetic average of fuel moisture values for days 
falling within the SC range of values for each fire weather class. 
Note that the user can edit these values. However, if you change 
these values, you must recalculate the fire danger rating 
parameters by clicking on the “Recalculate Indices” button. 
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The following information that appears on this form is calculated from the SC Subset and Fuel 
Moisture, Wind Speed, and Fuel Temperature entered above. It cannot be edited. 

 Calculated Spread Component (SC) 
 Energy Release Component (ERC)  
 Calculated Burning Index (BI)  
 Calculated Ignition Component (IC)  

SC Subset From The program defaults to the “Current Data” button on the right 
side of the screen while you are editing the form. However, there 
may be times when you have made changes to the Weather Class 
Data form and then decide to revert to the previous information. 
As long as you have not saved the changes using the “Save” button 
at the bottom of the screen, you may revert to the previous data by 
clicking on the “Previously Saved Data” button. This will reset the 
data to whatever was there when you opened the form. 

Retrieve Fuel Data Click on this button to retrieve the Analysis Area weather data 
using the SC Subset values shown above. 

Recalculate Indices Click on this button to recompute the danger rating parameters 
(SC, ERC, BI, IC) using the user-input values displayed above. 

Save Click on this button to save the user-specified and calculated 
values displayed on this form. 

Back Click on this button to return to the previous (Define Weather 
Class) form. 
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3.7  Manage Fuel  Character is t ic  C lasses 

 
Def ine  FCCs  

To define FCCs, click on the “Define FCCs” node on the Index Tree. The following screen, the 
Fuel Condition Class Data table, with a pull-down “Edit” menu in the top left corner and 18 tabs 
across the top will appear: 

This program area allows you to create and modify fuel characteristic classes 
(FCCs) for use in FETM. An FCC is a unique, qualitative, and quantitative 
description of the fuel profile from the mineral-soil interface to the top of the 
canopy. Where derivative fuel models are used to characterize fire behavior, 
FCCs are used to characterize the landscape composition and fire effects. 
Multiple FCCs may be assigned within an Analysis Area. 

Scientists from the Pacific Northwest Forestry Laboratory in Seattle, 
Washington are in the process of developing a comprehensive system of fuel 
characteristic classifications. The FCC library for FETM will eventually 
incorporate those classifications. In the meantime, FETM comes with a default 
set of FCCs. In this section, users can accept the default settings regarding these 
classifications, or can create FCC definitions with more detailed information 
regarding vegetation structure and fuel biomass. 



 

  60

The functions listed on the Edit menu are described in detail below under “FCC Edit Menu.” 
Each of the 18 tabs is described in detail in the “FCC Tabs” section, which begins on page 66. 

F C C  E d i t  M e n u  

You can access the FCC edit menu by clicking on “Edit” at the top left of the “Define FCCs” 
screen. The following pull-down menu will appear: 
 

Cut 
Copy  
Paste 

Ctrl + X
Ctrl + C
Ctrl + V

Add new FCC to user portion of database 
Copy FCC records to user portion of database 
Delete FCC Records 
ReNumber user portion of database 
Filter FCC records 
Undo all filters 
Restore FCC records to system portion of database 
Age class list 
Fuel category list 
Loading class list 
Other class list 
User group 
Vegetation type list 

 
The last six items on the menu can also be accessed by right clicking on any cell within the FCC 
tabs. This is discussed in further detail under FCC Tabs (see page 67). Each of these Edit menu 
selections is described in greater detail below. 

 
Cut This selection is a reminder of the control command that can be used 

to cut information from the FCC data table. You cannot actually use it 
to cut information from the table. 

You can use this command on a cell-by-cell or a line-by-line basis. To 
cut information from a cell, highlight the cell, then hold down the Ctrl 
key and press “X.” To cut an entire line, select the gray box to the left 
of the line or lines you want to cut, then hold down the Ctrl key and 
press “X.” FETM 4 is unlike other Windows programs you may be 
used to. Once you cut information, you cannot retrieve it.  
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Copy/Paste These selections are a reminder of the control commands that can be 

used to copy and paste information within the FCC data table. You 
cannot actually use them to copy or paste information within the table. 

You can use these commands on a cell-by-cell or a line-by-line basis. 
To copy information from a cell, highlight the cell, then hold down the 
Ctrl key and press “C.” Next, drag your cursor to the cell where you 
would like to insert the information, the hold down the Ctrl key and 
press “V.” To copy an entire line, select the gray box to the left of the 
line or lines you want to copy, then hold down the Ctrl key and press 
“C.” You can only copy one line at a time.  

Add new FCC to 
user portion of 
database 

Clicking on this menu item will add a new FCC number and row at the 
bottom of the FCC data table. You can then use the pull-down menus 
under each column to fill in the row. 

Copy FCC records 
to user portion of 
database 

To copy an existing FCC record, click in the gray box to the left of the 
FCC you want to copy, the click on this item on the “Edit” menu. The 
FCC information will be copied to the bottom row of the FCC table. 

Delete FCC 
Records 

To delete FCC records from the FCC data table, click in the gray box 
to the left of the FCC you want to delete. If you want to delete more 
than one FCC, you can hold down the Crtl key while you are selecting. 
Next, select “Delete FCC Records” from the “Edit” menu. A dialog 
box will appear that says, “Deleting these user-defined FCCs will also 
delete them from any scenarios where they are included. Do you want 
to continue?” If yes, click on the “Yes” button. If you want to go back 
and think about it again, click on the “No” button. There are 206 FCCs 
records that are system FCCs, meaning that they are associated with 
specific eco-regions. These FCCs cannot be deleted. However, 
selecting them under this command will cause them to be “hidden.” 
For instructions on how to retrieve these system FCCs, see “Restore 
FCC Records to System Portion of Database” on the following page 
(page 62). 

ReNumber user 
portion of database 

Once you have added, deleted, and copied FCCs, you will have gaps in 
your numbering system. This menu item lets you go back and 
renumber the FCCs in consecutive order. It will also replace the first 
four characters of any FCCs you have copied with the four-character 
identifier for this scenario. To renumber the FCCs, simply click on this 
option on the “Edit” menu. 
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Filter FCC Records This menu item allows you to create an FCC data table using specific 

characteristics. To use the filter feature, select “Filter FCC records” 
from the “Edit” menu. The screen shown below will appear.  

 
 You may sort by any of the column headings on the FCC data table. 

Click on the black arrow to the right of the “Filter On” field to see a 
list of filters available. You can also select the type of filter you wish 
to use. Filter types are specific to the filter you selected in the previous 
field. Click on the black arrow to the left of the “Type of Filter” field 
to see the selections available. Lastly, you can filter using the “Match 
Request” field. This field allows you to filter by word, letter, or 
number. Just type whatever you want to use into the field.  

Once you have selected your filter parameters, you can apply them by 
selecting the “Filter” button at the bottom left of the screen. To return 
to the previous screen, select “Close” at any time. 

Undo All Filters To return to a complete list of FCCs on the FCC data table, select 
“Undo All Filters” from the “Edit” menu.  

Restore FCC 
Records to System 
Portion of Database 

FETM 4 includes two types of FCC records—those that are user-
defined and those that are preloaded into the system. If you have 
“hidden” system FCCs using the “Delete FCC Records” command, 
you can retrieve them here. Simply select “Restore FCC records to 
system portion of database” from the edit menu. 
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The final section of the menu allows you to edit existing or create user-defined characteristics 
for the FCCs. In addition to accessing these items on the “Edit” menu, you can also right-
click on your mouse to see a list from anywhere within the tabbed screens. You can define 
characteristics in any of the following areas: 
 
Age Class List To define an age class, select “Age Class List” from the “Edit” menu 

or by right-clicking your mouse in any cell within the FCC tabs and 
selecting it from the pull-down menu. The screen shown below will 
appear.  

To redefine or replace an existing age class, simply highlight it by 
either clicking within the cell or by clicking on the gray square to the 
left of the row. Then type over the existing age class. All of the FCCs 
that had the previous characteristic will now list the new characteristic 
in the Age Class column. 

To add a new age class to the pull-down menu, click in the cell next to 
the asterisk (*). You may have to scroll down to see the bottom of the 
list. Type in the new age class you want to include, then select 
“Close.” This age class will now be available on the pull-down menu. 

 
Fuel Category List To define a fuel category, select “Fuel Category List” from the “Edit” 

menu or by right-clicking your mouse in any cell within the FCC tabs 
and selecting it from the pull-down menu. The screen shown below 
will appear.  

To redefine or replace an existing fuel category, simply highlight it by 
either clicking within the cell or by clicking on the gray square to the 
left of the row. Then type over the existing fuel category. All of the 
FCCs that had the previous fuel category will now list the new 
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category in the Fuel Category column. 

To add a new fuel category to the pull-down menu, click in the cell 
next to the asterisk (*). You may have to scroll down to see the bottom 
of the list. Type in the new fuel category you want to include, then 
select “Close.” This fuel category will now be available on the pull-
down menu. 

 
Loading Class List To define a loading class, select “Loading Class List” from the “Edit” 

menu or by right-clicking your mouse in any cell within the FCC tabs 
and selecting it from the pull-down menu. The screen shown below 
will appear.  

 

 
 

 To redefine or replace an existing loading class, simply highlight it by 
either clicking within the cell or by clicking on the gray square to the 
left of the row. Then type over the existing loading class. All of the 
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FCCs that had the previous class will now list the new class in the 
Loading Class column. 

To add a new loading class to the pull-down menu, click in the cell 
next to the asterisk (*). You may have to scroll down to see the bottom 
of the list. Type in the new loading class you want to include, then 
select “Close.” This loading class will now be available on the pull-
down menu. 

Other Class List To define an “other” class, select “Other Class List” from the “Edit” 
menu or by right-clicking your mouse in any cell within the FCC tabs 
and selecting it from the pull-down menu. The screen shown below 
will appear.  

“Other Class” is provided to let you tailor FETM 4 and the FCC 
definitions to your specific needs. For example, you may use the other 
class category to specify critical habitat, such as sage grouse or spotted 
owl. To redefine or replace a previously defined “Other” class, simply 
highlight it by either clicking within the cell or by clicking on the gray 
square to the left of the row. Then type over the existing other class. 
All of the FCCs that had the previous class will now list the new class 
in the Other Class column. 

To add a new other class to the pull-down menu, click in the cell next 
to the asterisk (*). You may have to scroll down to see the bottom of 
the list. Type in the new other class you want to include, then select 
“Close.” This other class will now be available on the pull-down 
menu. 
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User Group To define a user group, select “User Group” from the “Edit” menu. 

The screen shown below will appear.  

To redefine or replace an existing user group, simply highlight it by 
either clicking within the cell or by clicking on the gray square to the 
left of the row. Then type over the existing user group. All of the 
FCCs that had the previous group will now list the new group in the 
User Group column. 

To add a new user group to the pull-down menu, click in the cell next 
to the asterisk (*). You may have to scroll down to see the bottom of 
the list. Type in the new user group you want to include, then select 
“Close.” This user group will now be available on the pull-down 
menu. 
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Vegetation Type 
List 

To define a vegetation type, select “Vegetation Type List” from the 
“Edit” menu. The screen shown below will appear.  

 

 

 To redefine or replace a vegetation type, simply highlight it by either 
clicking within the cell or by clicking on the gray square to the left of 
the row. Then type over the existing vegetation type. All of the FCCs 
that had the previous type will now list the new vegetation type in the 
Vegetation Type column. 

  

To add a new vegetation type to the pull-down menu, click in the cell 
next to the asterisk (*). You may have to scroll down to see the bottom 
of the list. Type in the vegetation type you want to include, then select 
“Close.” This vegetation type will now be available on the pull-down 
menu. 

 
F C C  T a b s  

Each FCC appears on each of these tabs, and all of the information together makes up the 
definition of the FCC. Each FCC also has a unique code: for example, AF01-0001. The 
characters located to the left of the hyphen in the FCC name (here, AF01) represent the one- to 
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four-character code used to identify the Analysis Area (which was previously specified by the 
user under “Define Analysis Area”). The last four characters represent the FCC number within 
that Analysis Area. FETM 4 automatically assigns these numbers to FCCs as they are entered. 
You can choose to renumber these FCCs under the “Edit” menu on the “Define FCCs” screen 
(see page 61, ReNumber user portion of database, for additional explanation). The information 
displayed on each row of data across all of the tabs includes both quantitative and qualitative 
information that constitutes the full definition of the FCC for use in FETM 4. 

The 18 tabs generally fall into four categories: 

 FCC Characteristics 
 Fire Behavior, Type, and Size Characteristics 
 Wildland Fire Characteristics 
 Prescribed Fire Characteristics 

Each of these categories is described in greater detail below. In addition, all of the tabs have the 
following user buttons at the bottom of the screen: 

 Copy Fuel Profile 
 Save Column Widths 
 Close 

These user buttons are described in further detail following the discussions of each tab category 
(see page 72). 

You may also review fuel model details and edit information in specific columns by right-
clicking on any cell within the FCC tabs. The following pull-down menu will appear: 

 
Fuel Model Details 
Edit Other Class List 
Edit Age Class List 
Edit Derivative Fuel Model Data 
Edit Fuel Category List 
Edit Loading Class List 
Edit User Group 
Edit Vegetation Type List 

 
Screens for the Other Class List, Age Class List, Fuel Category List, Loading Class List, 
User Group, and Vegetation Type were shown previously under “FCC Edit Menu” (see pages 
62-66). The “Fuel Model Details” screen and “Edit Derivative Fuel Model Data” screen are 
discussed below. 
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Fuel Model 
Details 

This list allows you to review the fuel models that are associated with 
the FCCs in the tabbed tables. To see this table, right-click in any cell 
with the FCC tabs. The Derivative Fuel Model Table shown on page 30 
will appear. 

Edit Derivative 
Fuel Model Data 

Right-click on this menu item for a short cut to the “Define DFMs” 
section of FETM 4. This section of the program is described in detail on 
page 25 of this manual. 

F C C  C h a r a c t e r i s t i c s  

Tabs shown on this screen with pencil icons require user input. The currently active tab, whether 
it can be edited or not, is always displayed with a matchstick icon on it, and is always moved to 
the lowest tabbed row. Tabs without pencils show information that is calculated within FETM 4 
or values that have been entered elsewhere in the program. Tabs that require user input are 
identified with a pencil icon and are discussed below. 

 
FCC (Fuel 
Characteristic Class) 
Definition 

Click on this tab to view or 
edit qualitative information 
used to identify FCCs. To 
edit the white cells within the 
table, click on the cell you 
wish to edit. A gray box with 
a black arrow in it will 
appear to the right side of the 
cell, as shown. 

 Click on the arrow to display the appropriate drop down list for the 
column, then select the information that you wish to insert by 
clicking on the highlighted text. 

FCC Surface Fuel 
Loading 

Click on this tab to characterize the surface fuel associated with a 
particular fuel characteristic class. You can enter the following 
information: 

 Fuel Bed Depth 
 Total Duff 
 Duff Depth 
 Live Wood 
 Live Herb 
 Dead & Down (DD) Wood for periods of 1 through 10,000+ 

hours 
The program then automatically calculates Total DD Wood, Total 
Live Wood, and Total Live + DD Wood. 
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Stand Characteristics Click on this tab to view summary information on the stands 
associated with each FCC, including density weighted diameter at 
breast height (inches), density weighted total stand height (feet), 
total stand density (trees/acre), calculated canopy base height (feet), 
the calculated maximum crown bulk density found in 1-foot vertical 
layers through the stand (pounds per cubic foot), and the foliar 
moisture content (percent). 

 The foliar moisture content values must be placed here in order for 
the correct fire type to be calculated. The other fields cannot be 
edited here. The information required for populating these fields in 
entered through the “Define Stands” node on the Index Tree (see 
page 73 for more information). If no stand is defined, the fields will 
be blank. 

Fuel Model 
Assignment 

Click on this tab to view or edit the quantitative description of the 
fuel model assigned to each FCC. The fuel model assignment can be 
made either by selecting the desired model from the drop-down list 
in the column labeled “Derivative NFDRS Fuel Model” next to each 
FCC, or by using the “Define Derivative Fuel Model” node on the 
Index Tree (see page 25). You can also view the Derivative Fuel 
Model data for any FCC simply by double clicking on any data cell 
within the table. On this screen, the following fuel loading 
information can be edited: 

 Crown Fuel 
Loading 

Click on this tab to view information on the crown fuel loading by 
FCC for six fuel size classes: foliage, 1-hour wood time-lag fuels, 
total foliage + 1-hour wood time-lag fuels, 10-hour wood time-lag 
fuels, 100-hour wood time-lag fuels, and 1,000-hour wood time-lag 
fuels. All units are in tons per acre.  

 These fields cannot be edited here. The information required for 
populating these fields in entered through the “Define Stands” node 
on the Index Tree, which is discussed later in this user manual (see 
page 73). If no stand is defined, the fields will be left blank. 

 Surface Fuel 
Adjustments 

Click on this tab to view information on the mass of crown fuels that 
are deposited onto the surface in each of four fuel size classes: 1-
hour, 10-hour, 100-hour, and 1,000-hour. Note that the deposited 
foliage mass is added to the 1-hour mass. All units are in tons per 
acre.  

These fields cannot be edited here. The information required for 
populating these fields in entered under the “Define Stands” node on 
the Index Tree, which is discussed later in this user manual (see 
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page 73). If no stand is defined, the fields will be left blank. 

F i r e  B e h a v i o r ,  T y p e ,  a n d  S i z e  C h a r a c t e r i s t i c s  

Several of the FCC tabs address fire behavior characteristics that are applicable to both 
prescribed and wildland fires. These tabs are described below. 

Fire Behavior-
Surface ROS 

Click on this tab to view data on the calculated surface rate of spread 
(ROS) for each FCC by fire weather class. Information used to calculate 
these values was input in the “Define Weather Class” section of FETM 4 
and mapped from derivative fuel models to FCCs on the “Fuel Model 
Assignment” tab of this table. All units are in chains per hour (1 chain = 
66 feet). 

Fire Behavior-
Fireline 
Intensity 

Click on this tab to view data on the calculated surface fireline intensities 
for each FCC by fire weather class. Information used to calculate these 
values was input in the “Define Weather Class” section of FETM 4. The 
information was subsequently mapped to the FCCs using the specified fuel 
model assignments shown on the “Fuel Model Assignment” tab of this 
table. This tab also displays the calculated critical fireline intensity 
required for crown fire initiation. All units are in British thermal units 
(Btus) per foot per second. 

Fire Behavior-
Crown ROS 

Click on this tab for data on the calculated crown ROS for each FCC by 
fire weather class. Information used to calculate these values was input in 
the “Define Weather Class” section of FETM 4. The information was 
subsequently mapped to the FCCs using the specified fuel model 
assignments shown on the “Fuel Model Assignment” tab of this table. This 
tab also contains the calculated “Rate for Active Crowning” required for 
assessing crown fire propagation. All units are in chains per hour (1 chain 
= 66 feet). 

Fire Behavior-
Fire Type 

This tab shows the computed fire type (surface, passive crown, active 
crown) for each fire weather class by FCC (see Glossary for a description 
of fire types). 

Fire Behavior-
Potential Fire 
Size 

This tab includes the potential fire size for each FCC by fire weather class. 
All units are in acres per fire. The potential fire sizes for each FCC are 
calculated from the “Define Expected Fire Size” section of FETM 4 (see 
page 83). 

Fuel Moisture This tab contains 10-hour and 1,000-hour surface fuel moistures by fire 
weather class and by FCC. The units are all percent of oven-dry weight. 
These values are calculated in the “Define Weather Class” section of 
FETM 4. 
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P r e s c r i b e d  F i r e  C h a r a c t e r i s t i c s  

The following tabs provide information on prescribed fire characteristics associated with each 
FCC. The information on these tabs cannot be edited here. It is either input elsewhere in FETM 4, 
which will be discussed under the specific tab description, or is computed by FETM 4. 

Prescribed Fire 
Consumption 

Click on this tab to view data on total prescribed-fire fuel consumption by 
fire weather class. All units are tons per acre. The values are computed 
using the CONSUME 2.1 dynamic link library, which is accessed via the 
“Compute Fuel Consumption” node on the Index Tree (see page 86). 

Prescribed Fire 
Emissions 

Click on this tab to view information regarding the per-acre surface-fuel 
emissions from prescribed burning by pollutant, fire weather class (low, 
moderate, high, and extreme), and FCC. The per-acre emissions in tons 
per acre are given for the following pollutants:  

 Particulate matter less than 2.5 microns in aerodynamic diameter 
(PM2.5) 

 Particulate matter less than 10 microns in aerodynamic diameter 
(PM10) 

 Carbon dioxide (CO2) 
 Carbon monoxide (CO) 
 Non-methane hydrocarbons (NMHC) 
 Methane (CH4) 

W i l d l a n d  F i r e  C h a r a c t e r i s t i c s  

The following tabs provide information on wildland fire characteristics associated with each FCC. 
The information on these tabs cannot be edited here. It is either input elsewhere in FETM 4, which 
will be discussed under the specific tab description, or is computed by FETM 4.  

Wildland Fire 
Surface 
Consumption 

Click on this tab to view information on total wildland fire surface fuel 
consumption by fire weather class. All units are in tons per acre. The 
values are computed using the CONSUME 2.1 dynamic link library, 
which is accessed via the “Compute Fuel Consumption” node on the Index 
Tree (see page 86). 

Wildland Fire 
Crown 
Consumption 

Click on this tab to view information on the total consumption of crown 
fuels (all size classes combined) by weather class and by FCC. All units 
are in tons per acre. The values are computed using the CONSUME 2.1 
dynamic link library, which is accessed via the “Compute Fuel 
Consumption” node on the Index Tree (see page 86). 
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Wildland Fire 
Surface 
Emissions 

Click on this tab to view information regarding the per-acre surface-fuel 
emissions from wildland fire burning by pollutant, fire weather class (low, 
moderate, high, and extreme), and FCC. The per-acre emissions in tons 
per acre are given for the following pollutants: 

 Particulate matter less than 2.5 microns in aerodynamic diameter 
(PM2.5) 

 Particulate matter less than 10 microns in aerodynamic diameter 
(PM10) 

 Carbon dioxide (CO2) 
 Carbon monoxide (CO) 
 Non-methane hydrocarbons (NMHC) 
 Methane (CH4) 

Wildland Fire 
Crown 
Emissions 

Click on this tab to view information for each FCC regarding the per-acre 
emissions from wildland fire burning in crown fuels by pollutant and fire 
weather class (low, moderate, high, and extreme). The per-acre emissions 
in tons per acre are given for the following pollutants: 

 Particulate matter less than 2.5 microns in aerodynamic diameter 
(PM2.5) 

 Particulate matter less than 10 microns in aerodynamic diameter 
(PM10) 

 Carbon dioxide (CO2) 
 Carbon monoxide (CO) 
 Non-methane hydrocarbons (NMHC) 
 Methane (CH4) 

U s e r  B u t t o n s  o n  F C C  T a b b e d  S c r e e n s  

The following buttons appear on all of the tabbed screens under “Define FCCs”: 

Save Column 
Widths 

You may not be able to see all of the columns onscreen. To change the 
column widths, simply hold the cursor on the vertical line separating the 
column headings until a double vertical line appears(  ). Holding down 
the left mouse key, move the double vertical line to the left or right to 
change the column width. You can save the column widths on these 
screens by selecting the gray “Save Column Widths” button at the bottom 
of the screen. 



 

  74

Copy Fuel 
Profile 

To replace the fuel profile for the FCC with the corresponding fuel profile 
for its associated DFM, simply highlight the row (FCC) whose fuel profile 
you wish to replace by clicking in the gray box at the left side of the row. 
When the row is highlighted, click on the gray “Copy Fuel Profile” box at 
the bottom of the screen. This will replace the FCC fuel profile with the 
associated DFM fuel profile. The results will be displayed on the “FCC 
Surface Fuel Loading” tab. 

Close Click on this button or the “X” in the upper right corner at any time to 
close the FCC data table and return to the Index Tree. 

Def ine  S tands  

 

Click on “Define Stands” on the Index Tree to reveal the following form: 

In this section of FETM 4, you can include additional loading information that can be 
used to determine fire rates of spread and emissions. This program area also allows 
you to define stand characteristics that are common to more that one FCC, rather than 
having to define stand information for each individual FCC. Stands and their 
relationship to specific FCCs can be grouped using the following stand descriptors:  

 Species  
 Diameter at Breast Height 
 Height 
 Trees per Acre 
 Crown Class 
 Crown Ration 
 Proportion in Crown (Foliage, 1 Hour, 10 Hour, 100 Hour, 1000 Hour) 
 Proportion Cut 
 Proportion to Surface (Foliage, 1 Hour, 10 Hour, 100 Hour, 1000 Hour) 
 Proportion Boles Left 
 Proportion Rotten 

In this section you will also calculate the crown fuel loading once you have defined 
the stands. FETM uses the information developed in this section as input to the FCC 
definitions discussed in the previous section (see page 69). You can also delete 
specific stand information or entire stands within this section of the program. 
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You may wish to adjust the column widths to see all of the information on this form. To do so, 
simply hold the cursor on the vertical line separating the column headings until a double vertical 
line appears ( ). Holding down the left mouse key, move the double vertical line to the left or 
right to change the column width.  

This form shows the list of previously defined FCCs and any existing stand groups associated 
with those FCCs. To define a new stand group or to edit an existing stand group, select those 
FCCs you wish to include by clicking on the gray boxes in the “Include” column to the left of the 
FCCs you wish to specify. A red check will appear in the boxes you have selected. If you select 
an FCC by accident or change your mind, simply click on the box again and the check will 
disappear. 

Please note that all of the FCCs clicked at one time will be placed in the same stand group, so 
only click those that you wish to define together. If you choose FCCs that cross more than one 
existing stand group, you must choose one of the existing stand groups from a list (which will 
then be used to characterize all of the FCCs checked), or select a new stand group name with a 
new stand group definition to follow. 
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Once you have selected the FCCs that you wish to include, click on the “Define Stand Summary” 
at the bottom of the screen. The following screen will appear: 

At this point, you may take one of two actions—“Select from List” or “Define New Stand 
Group”—that are discussed in greater detail below. 

S e l e c t  f r o m  L i s t  

If you choose to select from the existing stand list, click on the radio button next to “Select from 
List,” highlight the existing stand definition that you wish to use, then click on the “Continue” 
button at the bottom of the screen. If you have not selected all of the FCCs that are currently 
included in the stand group, the following query will appear onscreen:  
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If you wish to list all of the FCCs that are currently included in this stand definition, select “Yes.” 
If you only want to keep those FCCs that you have specified on the “Include” form, select “No.” 
If you are not sure, select “Cancel” and go back and check, because there is no going back 
once you have changed the stand definition! 

You can redefine the stand group associated with an FCC by highlighting any other stand group 
name in the list, and then clicking on “Continue.” 

Once you have made this decision, the following screen will appear. You can use the gray scroll 
bar on the top left of the screen to see a list of all of the FCCs included in this stand definition. 
You can use the “Notes” box on the top right of the screen to enter any notes regarding the stand 
definition. 

 
You will need to use the scroll bars to see all of the data in the tabbed tables. This screen includes 
two input tabs—Definition and Assumptions—and two output tabs—Crown Mass and Profile. 
Each of these tabs is explained in greater detail below. 
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Definition Click on the “Definition” tab to define the stand species. Each table row 
contains data for a specific species included in the stand, as shown in the 
previous screen. You can change the species included in the stand by 
clicking on the black arrow to the right of the listed species and selecting a 
different species from the pull down menu. You can also add a species by 
clicking on the empty bottom row of the table and selecting a species from 
the pull-down menu. FETM 4 will automatically fill in the foliage 
information associated with the FCC, which you can then edit by clicking 
on the appropriate cell and typing over the existing information. 

 Copy Row This button is only functional on the “Definition” tab. To copy a row 
within the “Definition” screen, click in the gray box to the left of the 
“Species” row, then click on the “Copy Row” button at the bottom of the 
screen. You can select more than one row to copy by holding down the 
“Ctrl” key while you click in the gray boxes. The row or rows will be 
copied to the bottom of the species list. 

 Delete Row This button is only functional on the “Definition” tab. To delete a row 
within the “Definition” screen, click in the gray box to the left of the 
“Species” row, then click on the “Delete Row” button at the bottom of the 
screen. You can select more than one row by holding down the “Ctrl” key 
while you click in the gray boxes. A dialog box will appear with the 
message, “Are you sure you want to delete the selected rows?” Click on 
“Yes” to delete the highlighted rows. Click on “No” to return to the 
“Definition” screen.  

Assumptions Click on the “Assumptions” tab to identify the Crown Class Adjustments, 
Crown Fire Factors, and Equation Set used to define the current stand. The 
default values that are shown are those generally accepted by fuel and fire 
specialists. However, to change the default information, you can either 
click on the black arrows to show a drop-down box and select from the list 
provided, or you can highlight the information that you wish to change and 
type over it. Once you have input the changes, you can save your changes 
by selecting the “Save” button at the bottom of the screen. If you do not 
wish to save your changes, you may select the “Back” button, which will 
return you to the previous screen without saving your changes. The 
“Assumptions” screen is shown below. 
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Crown Mass  To see the crown mass computation based on your input, select the 

“Crown Mass” tab. The screen shown below will appear. To update the 
calculated crown mass data, select the “Compute Crown Mass” button at 
the bottom of the screen. (You can actually do this from any point within 
this section of the program.) 

 

 

 



 

  80

 
 
Profile To see a graphic profile of the data you have input, select the “Profile” tab. 

A sample profile screen appears below. The profile may look similar or 
significantly different, depending on the information you have input. 
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Delete Stand 
Definition 

To delete a stand that has been defined, click on the “Delete Stand 
Definition” button at the bottom of the screen. The following dialog box 
will appear, specific to the stand you have selected: 

 

 

 

 

 

 If you are sure you would like to delete the stand definition, select “Yes.” 
If there is any question in your mind, select “No” as there is no going 
back once you have deleted the definition. 
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D e f i n e  N e w  S t a n d  G r o u p   

If you choose to define a new stand group at the “Select Stand Group” screen (see page 75), click 
on the radio button next to “Define New Stand Group,” type in an abbreviation for the stand 
definition that you wish to create, then click on the “Continue” button at the bottom of the screen. 
The following screen will appear: 

You can use the gray scroll bar on the top left of the screen to see a list of all of the FCCs that 
you included in this new stand definition. You can use the “Notes” box on the top right of the 
screen to enter any notes regarding the stand definition. 

You will need to use the scroll bars to see all of the data in the tabbed tables. This screen includes 
two input tabs—Definition and Assumptions—and two output tabs—Crown Mass and Profile. 
These tabs are the same under “Define New Stand Group” as they are under the previous section, 
“Select from List.” Please return to that section (pages 75-81) for a detailed description of each of 
these tabs.  

C a l c u l a t e  C r o w n  F u e l  L o a d i n g  

This Index Tree item is non-functional. It is there simply as a reminder that the crown fuel 
loading is computed under “Define Stands.” 
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Def ine  P i l es  

  
 

  

 

 

 
 

To define a pile associated with an FCC or group of FCCs, click on “Select Analysis Area,” 
“Manage Fuel Characteristics Classes,” then “Define Piles” on the Index Tree.  The following 
screen will appear. 

 
 
If FCCs associated with piles are listed, you can select them in the “Include” column.  If not, you 
will need to define a new pile by selecting the “Define Piles” button at the bottom of the screen.  
Once you have done this, the screen shown below will appear.  You may exit this function at any 
time by selecting “Close” or clicking on the “X” in the upper right corner. 

This program area allows you to compute the fuel loading in piled slash by specifying 
the number of piles and the shape of the piles, among other characteristics. The pile 
wizard is the same as that used in the FASTRACS program. To use this program area, 
the “Pile” definition must be used for at least one FCC. This definition is applied in 
the “Fuel Category” column of the “FCC Definition” tab under “Define FCCs” screen 
(see page 59). If no piles are specified in that tab, you will get a “type mismatch” error 
when you try to use this section of the program.  
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First, type in a name for your pile definition.  This can be anything (e.g., location, type of pile, 
associated FCC number).  Then click on “OK.”  The following screen will appear. 
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The three tabs across the top allow you to fully describe the piles.  The first is “Pile Dimension 
and Quality.”  On this tab you will select pile shape and dimensions.  Click on the radio button 
next to the pile type you wish to use, or, to see examples of pile types, click in the white square 
on the left side of the screen.  The following screen will appear.  

 
 
Click on the appropriate pile type, then click on “OK.”  You will be returned to the previous 
screen and the radio button next to the pile type will be selected. 

Next, fill in the dimensions of the pile, then select another tab, either “Packing Ratio” or “Other 
Details.”  If you try to save or cancel at this point, you will receive an error message because 
more information is required. 

The “Packing Ratio” tab is shown below. 
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Select the appropriate radio button, then move to the “Other Details” tab, which is shown below. 
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Fill in the requested information, then select “Save.”   If you have not chosen “Pile” previously 
under the “Define FCCs” section of the program, you will receive the following error message: 

 
 
You will need to go back to that section of the program and include “pile” as a definition for at 
least one FCC under the “Fuel Category” column of the “FCC Definition” tab (see page 59 for 
additional information) before you can proceed with your pile definitions.  

You may exit this function at any time by selecting “Cancel” or clicking on the “X” in the upper 
right corner of the screen. 

 
Ass ign  Der iva t i ve  Fue l  Mode l  

 
 

 
 

To assign a derivative fuel model to a specific FCC, select “Assign Derivative Fuel Model” from 
the Index Tree under “”Manage Fuel Characteristic Classes.” The following screen will appear: 

This program area contains a wizard that allows you to map the FCCs to a single 
derivative fuel model, either manually or automatically, using a set of weighting 
factors.  
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Default factors will appear under the “Weighting Factors” heading at the top left of the screen 
and the “Fuel Category” will default to “All.” To change the default weighting factors, simply 
highlight the default factor and type in a new one. The fuel bed depth (in feet) may be any 
number greater than zero. As indicated on the screen, the Fine Dead & Down (DD) Loading is 
the loading in fuel element sizes that range in diameter from 0 to 0.25 inch. The weighting factor 
for Small DD Loading (as indicated, fuel elements sizes that range in diameter from 0 to 
3 inches) will be adjusted to balance the total of all three factors to 1.0. The default factors will 
not reset until you click on another area of the screen outside of the weighting factor box. 

To change the Fuel Category, simply select the appropriate radio button. 

The lower part of the screen contains a list of all FCCs currently defined in FETM 4 and the 
derivative fuel model currently assigned to them. Select those FCCs to which you wish to assign 
new Derivative Fuel Models by clicking on the appropriate gray box in the “Include” column. If 
you wish to see DFM recommendations or change DFM assignments for all of the FCCs, you can 
click on the “Select All” button at the bottom of the screen. You can also unselect all of the FCCs 
that you have highlighted and start over by selecting the “Unselect All” button at the bottom of 
the screen. 
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Once you have selected those FCCs that you wish to include, click on the “Run” button at the 
bottom left of the screen. The model will load the DFM recommendations and relative scores for 
those FCCs that you have included based on the weighting factors and fuel category that you 
have selected. 

At this point, you can do one of three actions: 

1. You can accept all of the recommendations by clicking the “Accept All” button at the bottom 
right of the screen. 

2. You can reject all of the recommendations by clicking the “Reject All” button at the bottom 
right of the screen. 

3. You can accept specific recommendations by highlighting the appropriate gray boxes in the 
“Accept” column on the right side of the screen, then selecting the “Run” button again.  

Once you have accepted and run the program, you can save your changes by clicking on the 
“Save” button on the lower left of the screen. 

You can exit anytime without saving your changes by simply selecting the “Close” button at the 
bottom of the screen or the “X” at the upper right. 

Def ine  Expec ted  F i re  S i ze  

 
To define this relationship, select “Define Expected Fire Size” from the Index Tree under 
“Manage Fuel Characteristic Classes.” The following screen will appear: 

 

This program area allows you to define the relationship between the final fire size and 
the fire rate of spread for each of four fuel categories: timber litter, slash, grass, and 
brush. 
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The graph on the left shows smaller fires up to 1,000 acres. The graph on the right shows all of 
the fires included. 

Several fields on this screen require user input. Each is described below. 

Select Fuel 
Category 

To select a fuel category (timber litter, grass, shrubs), click on the black 
arrow to the right of the “Select Fuel Category” field at the top left of the 
screen. Then highlight and click on the fuel category you wish to use. Fire 
size relationships should be defined for each of the four fuel categories 
accessible from the drop-down list. 

Select Small 
Fire Curve 
Equation 

Select the Small Fire Curve Equation that you wish to use by clicking on 
the black arrow to the right of the “Select Small Fire Curve Equation” 
field at the top left of the screen. Then highlight and click on the equation 
you wish to use. You should select the curve equation that provides the 
best fit to the points shown in the graph on the left side of the screen. 
These equations are explained in greater detail in a separate volume, 
Technical Documentation. 
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R^2 Field The equation and coefficient of determination (R^2) shown on the left side 
of the screen results from the curve equation selected for controlled fires 
of less than 1,000 acres. This is based on the relationship between the final 
fire size (acres) and the rate of spread (chains per hour) for controlled fires 
less than 1,000 acres in size. FETM 4 calculates this coefficient. 

Select Large 
Fire Curve 
Equation 

Select the Large Fire Curve Equation that you wish to use by clicking on 
the black arrow to the right of the “Select Large Fire Curve Equation” 
field at the top right of the screen. Then highlight and click on the equation 
you wish to use. These equations are explained in greater detail in a 
separate volume, Technical Documentation. 

R^2 Field The equation and coefficient of determination (R^2) shown on the right 
side of the screen result from the curve equation selected for escaped (i.e., 
right-hand side) fires only. FETM 4 calculates this coefficient. As stated 
on the screen, at least three fires must be associated with the curve for 
FETM 4 to make this calculation. 

Rate of Spread 
from IIAA 

You may select one of the following to define the Rate of Spread by 
clicking the appropriate radio button on the lower left of the screen: 

Frequency 
Weighting

Breakpoint rates of spread from the IIAA model are weighted by the 
number of fires that occur in the various FMZs that make up the Analysis 
Area. 

Area Weighting Breakpoint rates of spread from the IIAA model are weighted by the area 
of the various FMZs that make up the Analysis Area. 

Indicated Values Breakpoint rates of spread are specified by the user. If you use the 
indicated values, the “Acres” cells will turn from gray to white and you 
must fill in the appropriate breakpoint rates of spread. 

Empirical Data 
from Fires 

This spreadsheet is for entering information on historical fires within the 
Analysis Area that have escaped initial attack (i.e., greater than 1,000 
acres for IIAA users). You should enter the following information (in 
order from left to right): fire name, final fire size (acres; area within the 
controlled perimeter, including unburned acres), effective mid-flame wind 
speed (mph), active spread time of the fire (hours). Anderson’s fire size 
model is used to compute the effective rate of spread of the fire. Enter data 
from as many fires as exist (3 to 10 is ideal). 

Save Click here to save the data you have entered on this screen. If you do not 
wish to save the data, close without saving. 
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Close Click here to return to the Index Tree. 

 

Compute  F i re  Type  

 
To compute the fire type and populate the FCC data table with the computed fire type, click once 
on the “Compute Fire Type” node on the Index Tree. FETM 4 will automatically compute the 
data and a “Calculation Complete” dialog box will appear onscreen. Simply click on “ok” to 
make the dialog box disappear. 

Compute  Fue l  Consumpt ion   

 
To compute the fuel consumption and 
emissions, click once on the “Compute 
Fuel” node on the Index Tree. The box to 
the right will remain onscreen while  
FETM 4 automatically computes the data.  

A “Calculation Complete” dialog box will 
appear onscreen when the calculation is 
finished. Simply click on “ok” to make 
the dialog box disappear. 

This program area allows you to compute fuel consumption and emissions for both 
surface and elevated fuels using the same algorithms as those used in the CONSUME 
2.1 dynamic link library (version 2.01.0140). 

This program area lets you compute the fire type for each FCC based on the fire 
weather data, fuel loading, and topography specified previously in various parts of the 
model. The fire type is computed to be one of the following: surface fire, passive 
crown fire, or active crown fire. The algorithms used to determine fire type are the 
same as those used in the FireFamily+ system of models, and are described in the 
Technical Documentation for FETM. 
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4 Managing Scenarios 
 

 

4.1  New Scenar io  
To create a new scenario, click on the “New Scenario” under “Manage Scenarios” on the Index 
Tree. The following screen will appear:  

This program area allows you to set up scenarios using the data entered in the all of 
the previous Index Tree nodes. A scenario (also called a run scenario) is a set of 
assumptions used to define a modeling analysis within the Analysis Area. A scenario 
is defined by the following inputs and assumptions (partial list): FCCs to include, 
transition matrices that show effects of various fire and non-fire disturbances, 
schedule of management activities, pollutant type, years in simulation period, number 
of model iterations over which to average the results, and the levels of prescribed-fire 
treatment to include. 
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You will need to fill in the following information: 

Scenario Name Enter name. 

Scenario 
Description  

Enter scenario description (optional). 

Prescribed Fire 
Treatment 
Scaling Factors 

If more than one level of prescribed fire treatment is to be run in the 
scenario, you will need to define the scaling factors. To define the scaling 
factors, first enter a percentage increment to the right of the field labeled 
“Increment,” then click on the boxes to the left of the levels that you wish 
to include in the scenario. A check will appear in the boxes to the left of 
the selected levels. If you only wish to model the prescribed fire treatment 
schedule that will be input later in FETM 4, then put in a “0” increment 
and check only the box to the left of Level 4 (Baseline Schedule). 

Number of 
Years to Include 
in Simulation 

The range is 1 to 200 years, with a 100-year default. 

Number of 
Model Iterations 
over which 
Results Will be 
Averaged 

You can enter any number of iterations. The default is 30.  

Maximum Fire 
Size by Fuel 
Category 

Enter the maximum size of wildland fires that could occur within the 
Analysis Area by fuel category. The maximum size is always greater than 
or equal to the maximum controlled fire size of 1,000 acres. 

Pollutant 
Species 

Select one or more pollutant species to include in the scenario run by 
clicking in the box to the left of the pollutant species. A check will appear 
next to the selected species. 

Update FCC 
Data 

Click this button to update the scenario (hidden) using the data that are 
currently displayed on the FCC data table (under “Define FCCs” on the 
Index Tree).  

Save Click on the “Save” button to save the scenario you have created. 

Close Click on the “Close” button on the “X” in the upper right to return to the 
Index Tree. If you close without saving, your scenario will not be saved. 
Fortunately, FETM 4 will ask you first if you want to save your changes. 
Select “yes” if you do and “no” if you don’t. 

 



 

  95

 

4.2  Copy Scenar io  

 
To copy an existing scenario into a new scenario, 
click on the “Copy Scenario” node below “Manage 
Scenarios” on the Index Tree. The form to the right 
will appear onscreen: 

Highlight the scenario you wish to copy, then enter 
the new scenario name in the “Copy To” field. Click 
on the “Copy” button at the lower left of the form. 
When the scenario has been copied, a “Scenario 
Copied” dialog box will appear. Click “OK” to make 
it disappear. You can continue to copy scenarios at 
this point or select “Close” or “X” to return to the 
Index Tree. 

4.3  Delete  Scenar io  

 

To delete a scenario, click on 
the “Delete Scenario” node 
below “Manage Scenarios” 
on the Index Tree. The form 
to the right will appear 
onscreen: 

This section of the program allows you to copy existing scenarios, both those that 
have been run and those that have not. Copying a scenario is the only way to modify 
and run a scenario that has already been run. FETM will not allow you to modify a 
scenario that has been previously run. 

This section of the program allows you to delete existing scenarios, including those 
that have been run and those that have not. Deleting a scenario will result in the 
permanent removal of the scenario and all associated data, including model 
output. 
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Highlight the scenario you wish to delete and then click on the “Delete” button at the lower left 
of the form. The following warning box will appear: 

 

If you wish to continue (that is, delete), select “Yes.” If you wish to rethink your decision (that is, 
not delete), select “No.” 

You may select “Close” or “X” at any time to return to the Index Tree. 

4.4  Se lect  Scenar io  

 

To select a specific scenario, double-click on the folder icon that appears to the left of the 
scenario that you wish to work with. Scenarios that have been previously run and are locked will 
appear in the list with a lock icon to the right of them. 

Once you have selected a scenario, the Index Tree will expand to include the nodes discussed 
below. 

Def ine  Scenar io  Assumpt ions  

Clicking on the Define Scenario Assumptions node on the Index Tree will reveal the same form 
that appears when you create a New Scenario. See the “New Scenario” section (page 87) for a 
description of each field. 

Def ine  In i t i a l  F i re  F requency  

 

 

This section of the program allows you to select from a list of existing scenarios, both 
those that have been run and those that have not. You may view the information for a 
scenario that has been run, but may not change it. A lock icon to the right of the listing 
identifies scenarios that have been run. You can modify the information discussed in 
the following subsections for scenarios that have not yet been run. 

This program area allows you to specify the distribution of fires entered in the 
“Define Analysis Area” form by fire weather class. 
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Click on “Define Initial Fire Frequency” on the Index Tree to reveal the following form. (The 
total number of fires per year was entered previously in the “Define Analysis Area” form.) 

 
The user can edit the following areas on this form: 

Select Fuel Model for 
Determining Fire 
Frequency 

To select a fuel model to characterize fire frequency by fire weather 
class within the Analysis Area, choose the fuel model that dominates 
fire behavior in the Analysis Area from the drop-down list. 
Information regarding the fuel model characteristics is found in the 
“Define DFMs” section of this program. 

Select Number of 
Fires Based on 

Click on one of the following buttons to select the method by which 
the number of fires within the Analysis Area will be determined: 

 Percentage of  
Time in Range 

Click on this button to characterize the fire frequency distribution as 
a percentage of time in each spread component range. The fire 
frequency distribution is based on all weather conditions within the 
user-defined fire season. For example, if 15 percent of the fire 
season is characterized by low fire weather conditions, then 
15 percent of the fires are assumed to occur in the low fire weather 
class. The formula for each weather class is as follows: 

Frequency Fire TotalRange in Time of %  Class  WeatherinFrequency  Fire 







=

100
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 HAIA Distribution  
of Fires 

Click on this button to characterize the fire frequency distribution 
according to the HAIA distribution of fires. This fire frequency 
distribution is based on the weather specifically for those days on 
which fires occurred. This information is taken from the PCHA 
weather files. HAIA tracks the spread components for days on which 
fires occur during the specified fire season. These fires are then 
accumulated in the spread component “bins” for each fire weather 
class. For example, if 11.7 percent of the fires occur on days when 
the spread component ranges from 0 to 15, then 11.7 percent of the 
fires are assumed to occur in the low fire weather class. The formula 
is as follows: 

Frequency Fire Total
(%) Fires of onDistributi HAIA

  Class  WeatherinFrequency  Fire 







=

100
 

 User-Supplied  
Values 

Select this option if you want to input specific fire frequency 
information for this Analysis Area. Once you have selected this 
option, the “Fire Frequency in Analysis Area” cells on the form will 
turn from gray to white and you can input fire frequencies for the 
following fire weather classes: low, moderate, high, and extreme. 
Note that the total of the four fire weather classes must sum exactly 
to the total value shown, which cannot be edited here. To change this 
number, you will need to return to the “Define Analysis Area” 
screen in FETM 4. 

Fire Frequency in 
Analysis Area 

As discussed above, these cells only require input if you select 
“User-Supplied Values” in the previous area. Otherwise, they are 
calculated by the formulas shown above. If you choose to enter your 
own values, you will enter the fire frequency for each fire weather 
class in these cells. The total fire frequency must equal the number 
shown under “Total Fire Frequency” on the previously shown 
screen. 

Comments You may input any information within this cell. If you used “User-
Supplied Values” above, you may want to include specific 
information about how those values were derived. 
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The following information that is included on this form is derived from other forms within the 
FETM 4 program and cannot be edited here. 

Season Start and 
End Dates 

These are used to characterize the fire weather classes. 

SC Cumulative 
Frequency Range 

Spread component frequency range for the derivative fuel model 
selected. This range was specified previously on the “Define Weather 
Class” form. 

Percentage of Time 
Occupied by Each 
Fire Weather Class 

This range was specified previously on the “Define Weather Class” 
form. 

HAIA Distribution 
of Fires 

Information by fire weather class for derivative fuel model selected. 
This is a calculated value from the HAIA program that includes all of 
the fires in each selected administrative unit. 

Number of Fires in 
Administrative 
units 

This is the same as the HAIA Distribution of Fires, except that the 
distribution of fires is based on the total number of fires within all of 
the administrative units included in the Analysis Area, not just those 
fires within the actual Analysis Area. Consequently, these two 
numbers may differ if only parts of an administrative unit are included 
within the Analysis Area. 

Fire Frequency in 
Analysis Area 

As discussed previously, you cannot edit these cells if you choose to 
select the number of fires based on either the Percentage of Time in 
Range or the HAIA Distribution of Fires. 

Click on “Save” to save the values as currently displayed on this form. If you do not wish to save 
the changes you have made, simply close the form without saving. 

Click on “Close” or “X” at any time to return to the Index Tree. 

 

Se lec t  D is tu rbance  Types  

The user must select from a list of 10 available disturbance types. You will define the effects of 
the disturbances you identify later under “Define Disturbance Effects” (see page 95). 

Click on the “Select Disturbance Types” node on the Index Tree to reveal the following form: 
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The model will account for the disturbance types in the order they are listed. Management 
activities are always accounted for before prescribed fire, insect/disease, wildland fire, or natural 
selection. 

The form will default to “Management Activity” and “Disease/Insect,” as shown in the previous 
screen. To edit the fields, highlight the default text and type in the name of the disturbance type 
that you wish to include. Some examples are thinning, final harvesting, or firewood collection. 

Once you have named the disturbances and listed them in the order you wish them to be 
considered, click in the appropriate boxes in the “Include” column to include the disturbance type 
in the analysis. One or any combination of the disturbances may be checked. 

To save the list of disturbance types to be included, click on the “Save” button at the bottom of 
the screen. To close the form and return to the Index Tree, click on the “Close” button or the “X” 
in the upper right. 

 



 

  101

Se lec t  FCCs  

 

To select the FCCs, click on the “Select FCCs” node on the Index Tree. The following form will 
appear onscreen: 

 

To include a FCC in the scenario run, simply enter the number of acres in the FCC in one or both 
of the two right-most columns on the form. Acres can be entered in one or both of the columns 
labeled “Managed Initial Acres” (i.e., area on which mechanized equipment is permitted—
essentially commercial forest or rangeland) or “Natural Initial Acres” (i.e., area on which 
mechanized equipment is not allowed—essentially non-commercial forest or rangeland). Once 
you have entered acreage in either of these columns, a red check mark will appear in the 
“Include” column next to each FCC for which acreage has been entered. You cannot check the 
“Include” box itself; the check mark appears only after acres have been entered for the FCC. If 
you do not wish to include an FCC, simply set both acreage figures to zero.  

When you are satisfied, click on the “Save” button in the lower left corner and then on the 
“Close” button to close the form. 

 

In this program section, the user selects the FCCs that are to be included in a run 
scenario. 
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   Ass ign  Prescr ibed  F i re  P r io r i t y  

 

To assign the prescribed fire priority, click on the “Assign Prescribed Fire Priority” node on the 
Index Tree. The following form will appear onscreen: 

 

 

 

 

 

 

 

 

 

 

 

 

 

To assign a prescribed fire priority level to an FCC in the scenario run, simply enter the number 
corresponding with the level of priority in the column labeled “Priority” on the right side of the 
form. The levels of priority are determined by the number assigned to each FCC in this form. The 
lower the number that is assigned, the higher the priority of that FCC, with the number “1” being 
the highest level of priority. The number of levels of priority are determined by the number of 
FCCs that are within a specific vegetation type. For example, if there are only eight FCCs within 
the ponderosa pine vegetation type, then there can only be up to eight priority levels assigned. If 
you do not wish to assign a priority level to an FCC, leave the field blank.  

In this portion of the program, the user assigns the level of prescribed fire priority to 
each FCC within a vegetation type in a run scenario. The priorities are used only when 
the scheduled number of treatment acres exceeds the number available in any year. In 
this event, the “excess” treatment acres are taken from the highest priority FCC within 
a vegetation group. If no priorities are assigned, the “excess” acres are simply ignored 
and the actual acres treated will be less than the number of acres scheduled.  
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When you are satisfied, click on the “Save” button in the lower left corner and then on the 
“Close” button to close the form. 

Schedu le  Management  Ac t i v i t i es  

  

Click on “Schedule Management Activities” under the “Manage Scenarios” section of the Index 
Tree to reveal the following form: 

 

In this portion of the program, you may specify the number of acres treated by FCC 
and by year for each of the four available management activities, for prescribed fire 
(baseline level only), and for each of the three insect and disease disturbance types. 
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Select the disturbance type that you wish to schedule for from the drop down list at the top of the 
screen. You must then decide to schedule either by FCC or by vegetation type and age.  

If you select FCC, click on the radio button to the left of “FCC,” then select the first FCC that 
you wish to schedule. You must then enter the start year (FETM 4 will default to “1”), the end 
year, and the number of acres to be treated. You may choose to enter the treatment cost per acre; 
it is optional. Another line will appear on the list once you have entered the required information. 
You may continue to add as may FCCs as you would like to schedule. Any FCCs that are 
unscheduled are assumed to be undisturbed by the activity. Be sure to schedule the entire period 
from year 1 through the final year in the simulation.  

V i e w  S c h e d u l i n g  P r o g r e s s  

Click on the “View Scheduling Progress” node below the “Schedule Management Activities” 
node on the Index Tree to reveal the following form:  

 

This form is a list of those FCCs that have and have not been scheduled for each disturbance 
type. 
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Def ine  D is tu rbance  E f fec ts  

 

Click on “Define 
Disturbance Effects” 
under “Select Scenario” 
and the scenario name on 
the Index Tree to reveal 
the form to the right: 

 

 

This program area requires the user to specify the effects of the disturbances that were 
selected under “Select Disturbance Types.” The effects are specified as a fraction of the 
target FCC, which is allocated to one or more FCCs as a result of the disturbance. 
Disturbances are either those specified previously under “Select Disturbance Types” (see 
page 90) or disturbance effects from fire.  

Disturbance effects from fire are specified by fire intensity level. The user is required to 
specify the effects for FIL 1 and 2 fires, for FIL 3 and 4 fires, and for FIL 5 and 6 fires. To 
define the disturbance effects for FIL 1 and 2 fires, click on the down arrow on the right-
hand side of the “Disturbance Effects Matrix” field and select “Fire (FIL 1 & 2)” from the 
drop-down list. Then select the FCC to be disturbed from the field labeled “Transition From 
FCC.” The selected FCC will be displayed in the first column on the left in the work sheet.  

Next, select the FCC that the selected FCC (AF01-0001, in this case) will move to as a 
result of disturbance from FIL 1 & 2 fires. The fraction of “From FCC” area that moves to 
the “To FCC” area each year as a result of disturbance is shown in the column labeled 
“Transition Factor.” 
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To view the data at any time in matrix format (“FCC” rows by “FCC” columns), click on the 
“View Matrix” button on the lower left-hand side of the screen. 

Ass ign  F i re  Wea ther  C lass  fo r  P rescr ibed  F i re  

Click on “Assign Fire Weather Class” under “Select Scenario” and the scenario name on the 
Index Tree to reveal the following form: 

 

The user must select the fire weather class that each FCC will be burned under by prescribed fire. 
To select the fire weather class for each FCC, simply click on the appropriate weather class box 
next to each FCC number. Clicking on “Select All” will allow you to specify that every FCC will 
be burned under the same fire weather class (low, moderate, high, or extreme).  
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Update  FCCs  

Click on “Update FCCs” under “Select Scenario” and the scenario name on the Index Tree to 
update the current scenario data table using data from the FCC data table (see “Define FCCs,” 
page 59). A dialog box with “Are you sure you want to update the scenario FCCs using the 
information displayed in the FCC Data Table?” will appear on screen. If you want to update the 
FCCs, click on “Yes,” if not, click on “No.” The FCC data table cannot be viewed here. See 
“Update FCCs” or “View Graphs and Reports” for more information on viewing the FCC data 
table. 

Manage  Scenar io  Economics  

In this section of the program, you can define 
economic assumptions, net value change, fire 
suppression costs, and fuel treatment costs. To access 
these areas, click on “Manage Scenario Economics” 
under “Select Scenario” and the scenario name on the 
Index Tree. The Index Tree will expand as shown. 
Each of these areas is discussed in greater detail below. 

D e f i n e  E c o n o m i c  A s s u m p t i o n s  

Click on “Define Economic Assumptions” on the 
Index Tree to reveal the form to the right. The Net 
Value Change (NVC), Fire Suppression Costs (FSC), 
and Fuel Treatment Costs (FTC) fields are imported 
from IIAA (via HAIA) and cannot be edited. You 
can, however, edit the Monetary Target Year. If the 
Monetary Target Year is greater than the NVC, FSC, 
and FTC base years, then the Current Dollar 
Adjustment Factor is used to escalate costs from the 
base year to the target year. Costs and revenues 
occurring in any future year (that is, any year greater 
than the target year) will be discounted to the target 
year using the real discount rate that you enter in the 
middle of the form. 

If you make changes to the form and wish to revert to 
the HAIA numbers, simply click on the “Revert to 
HAIA” button on the lower left side of the screen. To 
save any changes you have entered, select the “Save” 
button before you close the screen. Click on “Close” 
to return to the Index Tree. 
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D e f i n e  N e t  V a l u e  C h a n g e  ( N V C )  

Click on “Define Net Value Change (NVC)” on the Index Tree to reveal the following form: 

 
There are two tabs on the form: Timber & Range Resources and Other Resources. You may 
either enter user-specified NVC values by fire intensity level for each resource (click on the 
boxes in the column labeled User-Defined Value, then enter the NVC values in the white fields), 
or use the HAIA-specific values for the Analysis Area (click on the boxes in the column labeled 
HAIA Values).  

In this example, there are no FCCs mapped to Timber & Range Tables. To map an FCC to a 
specific timber or range table, click on the Map FCC to Timber & Range Tables button in the 
right center of the screen, then select the appropriate timber and range table from the list 
displayed. Continue for each FCC in the drop-down list shown above. 

D e f i n e  F i r e  S u p p r e s s i o n  C o s t s  

Click on this Index Tree node to enter the fire suppression costs by wildland fire size ranges in 
each of six size ranges. 

You can either (1) specify your own values by clicking on the User-Defined Values, or (2) use 
the values from HAIA by clicking on the HAIA Values button. 
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D e f i n e  F u e l  T r e a t m e n t  C o s t s  

This is a placeholder node on the Index Tree. It is here to remind you to enter the fuel 
treatment costs by FCC on the Schedule Management Activities form (see Schedule 
Management Activities node on Index Tree). 
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5 Run Model 
 

 

5.1  Not  Yet  Run 
Clicking on “Not Yet Run” on the Index Tree will reveal the following form: 

 

Scenarios may be run once they have been defined. The Run Model node on the Index 
Tree is divided into two parts: scenarios that have not yet been run (Not Yet Run), and 
scenarios that have already been run (Previously Run). Both of these functions are 
explained below. 
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Click again on the name of the scenario to reveal a run status form, with tabs for different groups 
of data. The fields in the run status form will contain one of three messages: complete (gray 
background), questionable (yellow background), or incomplete (red background). The Run 
button on the form will be disabled if there are any “incomplete” messages on any of the tabs in 
the form. The Run button will be enabled if all of the status messages are either “complete” or 
“questionable.”  

For a description of the screening criteria used to determine the run status, click on the column 
heading in the form and then hold the cursor still until the tool tip appears.  

Note that the “Load Model Outputs” button at the bottom of the form is disabled for all scenarios 
that have not yet been run. For scenarios that have been copied from previously run scenarios, 
data are available for loading and the button is enabled. 

5.2  Prev iously  Run 
The “Previously Run” node on the Index Tree operates in the same way as the “Not Yet Run” 
node described above. The only difference is that output data may be loaded for previously run 
scenarios. To load output data from FETM 4 for graphing and reporting purposes, simply click 
on the “Load Model Outputs” button at the bottom of the form. 
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6 View Results 
 
 

 

6 .1  Graphs 
Graphical output from all previously run scenarios may be viewed or printed by clicking on 
“View Graphs” on the Index Tree. To view or print a graph, select the appropriate scenario from 
the drop-down list at the top of the form that appears (see example at right), then click on the box 
next to the type of graph that you wish to produce. Additional graphing instructions (selections) 
will then appear. The subsequent steps needed to produce a graph should be clear from the 
selections on each graphing form. 

In this section of the program, the user can develop and print a variety of graphs 
and reports showing the economic and environmental tradeoffs resulting from the 
variables input throughout the FETM modeling process. Available graphs include: 

 Time-Series Plot of Landscape Composition ** 
 Landscape Composition in Selected Year ** 
 Time-Series Plot of Fire Emissions 
 Fire Emissions by Prescribed Fire Treatment Level in Selected Years 
 Surface Plot of Fire Emissions by Year and Treatment Level 
 Time-Series Plot of Wildland Fire Acres 
 Time-Series Plot of Fuel Treatment Acres 
 Time-Series Plot of Area-Average Fuel Loading 
 Cost-Benefit Analysis of Fuel Treatment 

**FCC specific graphs that permit outputs that are grouped according to user-
defined categories (e.g., wildlife habitat types) 

Reports can be developed based on scenario or cost-benefit analyses or specific 
analysis area characteristics. 

Annotated sample graphs and reports are found in Appendix B of this manual. 
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Note that on any of the graphs, a table with the graphed values can be displayed by clicking on 
the “Generate Table” button at the lower left of the graph form. This button is enabled only after 
the graph has been generated. Click on the “Generate Graph” button, wait until the graph 
appears, then click on the “Generate Table” button. You can highlight the values in the table, 
copy the values to the clipboard by pressing “Ctrl” and “C” at the same time, and then paste the 
values into another document by pressing “Ctrl” and “V” at the same time (or by using the 
“Paste” function available in the application being used). 

6.2  Reports  
Reports containing the scenario-specific data may be viewed and printed by clicking on 
“Reports” on the Index Tree under “View Results.” To view or print a report, select the scenario 
from the drop-down list at the top of the form that appears (see below for example), then click on 
the box next to the type of report that you wish to review. 
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